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The Index contains a list of all Help topics available for WinCat Help. For information on how 
to use Help, press F1 or choose Using Help from the Help menu.



 Quick Overview
This Quick Overview tells you briefly how WinCat works :

With WinCat you can create a catalog (or database) of all files that hide on your floppydisks, 
CD-ROM's, harddisks etc.
WinCat offers powerful functions to quickly find any file you're looking for ; apart from 
searching for files by filename or description,    you can tell WinCat to show you for instance 
all graphic files or all document files.
Once you've found the file you were looking for, you can easily work with that file using 
WinCat's 'Restore File' function. With a single click of the mouse, you can start the Windows 
(or DOS) application that's associated with the file ; for instance, it will run the PaintBrush 
application to edit a BMP picture,    NotePad to edit a text-file, or WinZip to handle a ZIP 
archive-file.

When you are new to WinCat, please read the short tutorial below. It explains WinCat's main 
windows and functions, enabling you to use WinCat instantly. Click on every button or 
(green) underlined text to display the windows and additional information.

When you start WinCat you'll see the Volume List window, which shows all the disks in the 
catalog, and a few actions buttons.

To add a disk to the catalog, click the  button. WinCat will then display the Drive Select
window, where you can select which disk (from which drive) you want to catalog.

After cataloging a disk, use the  button to display the Volume Information window, 
where you can enter a description for this disk, and optionally assign a group-, location- 
and/or owner-id to it.

You can display all directories on a disk by selecting it on the Volume List window (just click 

once on it) and clicking the  button. On the Directory List window that will be displayed
you can select a specific directory and display all files in it.

Click the  button to display all files that are on the selected volume. You can also do 
this by double-clicking a volume entry.

When you want to search for files, click the  button to display the 
Search Files window, which enables you to search files by filename, extension, comment 



etc..
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Questions and Answers
Q - When cataloging a disk, I get message 'Unable to create file C:\WINDOWS\WINCAT\
ARCHIVES\Fxxxxxx.ACT'. How come ?
A - When cataloging a disk, WinCat scans the archive-files (like ARJ and ZIP) on the disk, in 
order to determine their contents. WinCat wants to save this information in a file named 
Fxxxxxxx.ACT, in the (default) C:\WINDOWS\WINCAT\ARCHIVES directory. If this directory 
doesn't exist then WinCat cannot create the file ; hence the message.
You must create the C:\WINDOWS\WINCAT\ARCHIVES directory to enable WinCat to catalog 
the contents of archive-files.
If you want WinCat to use another directory to store it's ACT files, you must create that 
directory AND specify it's name on the 'Configure' window as 'Archive contents directory'.
See also Cataloging Archive Contents

Q - When I print labels with WOODLE, they are either too wide or too long.
A - In order to use WOODLE, your printer must be able to print the same amount of Dots-Per-
Inch (DPI) horizontally and vertically, eg. 300x300 or 180x180 DPI.
Some matrix-printers (like the Epson LX-8000) offer non-symmetric resolutions like 240x144 
DPI ; when you print labels with this resolution they will have the wrong size : instead of 
2.75" x 2.75" they will be printed (240/240)*2.75" x (240/144)*2.75" = 2.75" x 4.58".

Q - The File List window's VIEW option has predefined classes like Programs, Archives etc.
Can I customize these or add my own ?
A - Yes. See View

Q - Can I customize which program to run when clicking the FileManager and TaskManager 
buttons on the Volume List window ?
A - Yes. See File- and TaskManager

Q - I have a disk cataloged, which holds 10,000 files ; yet the File List window only shows 
4,999.
A - That's the maximum number of files the File List window can display at a time. But 
instead of scrolling through a huge list, why not use the 'Directory List' window to display 
files in each directory ?
See also Program Limitations

Q - When using the Search Files window, I always get an empty File List window.
A - Suppose you want to search for a file named VBRUN100.DLL ; there are several ways to 
find it :

Filename : VB
Filename : 100
Filename : VB Extension : DLL

NEVER use DOS wildcard-characters ; if you enter VB* as filename, WinCat won't find 
anything. 
See also Search Files window

Q - Can I let WinCat open a catalog immediately upon startup ?
A - Yes. See Automatically Opening a Catalog

Q - I'm female, between 20 and 30, tall, slim, short hair (yep, I look like a tomboy), have an 



impossible sense of humour, like to ride my bike, I'm single and
A - STOP sqeezing your mouse... CALL ME !!!



Volume List window
When you start WinCat you'll see the Volume List window, which shows all the disks in the 
catalog. Click on any button, menu or field to see a description of it's function :



Icon
As a default, WinCat uses it's built-in icons to distinguish between 3.5" HD, 3.5" DD, 5.25", 
CD-Rom and hard-disks.
Tip
You can change the icon displayed for a particular volume by selecting the Change Volume 
Icon option on the 'Volume' menu.



Volume-ID
This is the label that's on the disk, or the name you assigned on the Catalog Disk window..
Tip
You can change the volume-ID by selecting the Rename button on the Volume List window, 
or by selecting the 'Rename' option on the 'Volume' menu or the pop-up-menu.
If possible, let WinCat use the disk's label as volume-ID. This enables WinCat to recatalog a 
disk if you add the same disk again to the catalog.



Contents description
This is a short description of the disk's contents. You can enter or change this description on 
the Volume Information window.
Tip
With the Select Volume Group function on the 'Volume' menu you can limit the volumes 
displayed to only those that have a certain character-string in this description-field.



Free space
This is the amount of free space left on the disk ; it will be displayed as nnnnK (where K is 
1,000 bytes), or as nnnnM (where M = 1,000,000 bytes).
Tip
Selecting the 'Sort by Free Space' option on the 'Sort' menu will sort all volumes in 
ascending or descending free space order. 
With the Select Volume Group function on the 'Volume' menu you can limit the volumes 
displayed to only those that have a minimum of nnnK free space.



Number of files
This is the number of files on the disk.



Group-ID
This is the Group-ID which you can optionally assign to a disk, using the Volume Information 
window. You can use this field to distinguish between Windows Utility disks, installation 
disks, DOS disks etc.
Tip
Selecting the 'Sort by Group' option on the 'Sort' menu will sort all volumes by group-ID.
With the Select Volume Group function on the 'Volume' menu you can limit the volumes 
displayed to only those that belong to the selected group.



Archive Icon
This icon will be displayed if you made WinCat catalog the contents of archive files like ARJ 
and ZIP.
If this icon is displayed, you can have a peek into each archive file on this disk by selecting 
the Show Archive Contents button or menu-option on the File List window.



Directory Icon
This icon will be displayed if the disk contains (sub)directories.
Tip
By clicking the Show Directories button on the Volume List window, or by selecting the 'Show
Directories' options on the 'Volume' menu or pop-up-menu, you can display the disk's 
directory.



Short Help information
When selecting a menu on the Volume List window, or when moving the mouse-pointer on 
top of one of the buttons, this line will show a short description of the menu's or button's 
function.
Tip
You can make WinCat display this information in either English, French, German or Dutch by 
selecting the appropriate 'Language' option on the Configure window



Registration Information
If this line shows the text 'Unregistered Evaluation Copy', it means you should take a look at 
the How To Order section in the Help file...
After you've registered WinCat your name will appear here, making it clear to everyone who 
peeks over your shoulder that you're a very nice person indeed.



Mouse Functions
Click the left mouse-button once on a disk-entry to select this disk.
Double-click the left mouse-button on a disk-entry to display the File List window, showing all
files on the selected disk.
Click the right mouse-button once on a disk entry to select this disk, and to display a pop-up-
menu, showing the same options as the 'Volume' menu.



Catalog menu
Used to open or create a catalog, to save the currently open catalog, or to show statistics 
about the currently open catalog.
Options :

Catalog Statistics
Open Catalog
Save Catalog
Save Catalog As
Save Group As
Exit
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Volume menu
Used to work with the selected volume, to add new disks to the catalog or to limit the 
volumes displayed to a certain group.
Options :

Show Information
Show Files
Show Directories
Rename Volume
Erase Volume
Add New Volume
Change Volume Icon
Select Volume Group

Tip
When clicking the right mouse-button on a volume entry, a pop-up-menu will appear which 
shows the same options as the Volume menu. 



Sort menu
Used to sort the volumes displayed on the Volume List window in a particular order.
Options :

Volume-ID : sort by Volume-ID
Free Space Asc.: sort by free space, volume with least free space at top
Free Space Dsc.: sort by free space, volume with most free space at top
Group : sort by group



Files menu
Used to search for files by name, description etc., or to display previously tagged files.
Options :

Search Files
Display Tagged Files
Reset File Tags



Utilities menu
Used to perform special functions, like importing file-descriptions, printing listings or 
disklabels, etc.
Options :

Compare
Import
Export
Report
Print Disklabels



Options menu
Used to configure WinCat ; you can define directories, programs and options using the 
'Configure' option, and you can customize the layout of WinCat's windows with the 
'Customize...' options.
Options :

Configure



Help menu
WinCat help and ordering information.
Options :

Contents : displays the Help file
Search for... : allows you to search for a help topic by keyword
Register
How to Order
About AidWare



Change Volume Icon window
If you select one of the two first options on the 'Customize Volume List' window, the Volume 
List window will show an icon for each volume in the catalog.
As a default, WinCat will use it's built-in icons, giving a visual clue whether a volume is a 3.5"
HD, 3.5" DD, 5.25", CD or harddisk.

To change the icon displayed for a particular volume, select the 'Change Volume Icon' option 
on the 'Volume' menu.
This will open a small window, showing all icons contained in the WINCATIC.DLL icon library 
that comes with the WinCat package.
To change a volume's icon, first select that volume on the Volume List window (just click 
once on it), and then double-click the desired icon on the Icons window. The entry on the 
Volume List window will then show the new icon.    

To retrieve icons from other icon libraries (for instance the Windows' supplied MORICONS.DLL
or PROGMAN.EXE), select the 'Open Icon Library' menu option on the Icons window. This will 
show an 'Open File' dialog, where you can select any EXE, DLL or ICL icon library, or a 
discrete ICO file.

Note : only select icons from libraries that reside on your harddisk(s), NOT from removable 
disks ! Obviously, WinCat will not be able to load an icon from a file residing on a disk which 
has been removed from the drive. If this situation occurs, WinCat will display the default 
icon.

Note : assigning your own icons to volumes will slow down opening a catalog, because 
WinCat has to load the icons from the icon libraries every time you open the catalog. 
However, this 'slow down' effect will only be noticeable if you have lots of disks with custom 
icons in the catalog.          



File List window
This window is used to display all files on a volume, files in a particular directory or files that 
were found by the search function.
Click on any button, menu or field to see a description of it's function :



Icon
WinCat uses a few icons to distinguish between several file-types. Icons used are :
Running file : executable EXE,COM, BAT and PIF files
Box : archive files (like ARJ and ZIP)
Pallet : graphic files (like BMP, GIF and PCX)
Pencil : document files (like TXT, DOC and WRI)
Speaker : WAV soundfiles

Other files will be displayed with the default 'File' icon.



Filename and filename-extension
This is the name of the file (how obvious...)



Size
The size of the file in bytes. If it's size is equal to or exceeds 10 megabytes, it will be 
displayed as nnn.nM.



Date
The date this file was created or last modified.
Tip
You can select the format in which the date is displayed (MM-DD-YY or DD-MM-YY) on the 
Configure window.



Volume-ID
This is the name of the volume that contains the file.



Description
You can optionally assign a description to each file, using the File Information window.
Tip
Alternative (and less tedious) ways to enter descriptions are :
- Using the Copy, Edit and Paste functions on the 'Utilities' menu.
- Using the Import function which imports file-descriptions from ASCII textfiles, for instance 
indexlistings on CD's, BBS AllFiles listings, 4DOS descript.ion files etc.
Clicking the Alternate Display button or menu option will show the directory of this file. 



Tag
If you tag (mark) a file using the Tag File button or menu-option, this will be indicated by 
displaying a red LED.
Tip
To remove the tag, click the Tag button once more.
To remove tags from all files, select the 'Clear File Tags' option on the Files menu.



Mouse Functions
Click the left mouse-button once on a file-entry to select that file.
Double-click the left mouse-button on a file-entry to display the Restore File window
Click the right mouse-button once on a file entry to select this file, and to display a pop-up-
menu, showing the same options as the 'File' menu.



Short Help information
When selecting a menu on the File List window, or when moving the mouse-pointer on top of
one of the buttons, this line will show a short description of the menu's or button's function.
Tip
You can make WinCat display this information in either English, French, German or Dutch by 
selecting the appropriate 'Language' option on the Configure window



Status information
This line shows how many files were selected by the 'show all files on volume', 'show all files 
in directory' or 'search files' functions.
It also tells you what the current sort-order is, and what filetypes are currently being 
displayed (as selected on the View menu).
Tip
If the File List window shows no files at all after a file search, of when you want to display all 
files in a directory or on a volume, have a look at this line. If it doesn't say 'All entries', the 
empty display might be caused by the fact that you have selected a function class which 
filters out all entries.    



File Menu
Used to work with the selected file.
Options :

Show Information
Define Association
Restore File
Show Archive Contents
Tag File
Alternate Display
Exit



Sort Menu
Use this menu-option to select how you want the displayed files to be sorted : in filename, 
extension, directory, volume, date or size (in descending or ascending) order.



View Menu
With these menu-options you can limit the files displayed to those belonging to a certain 
function class, e.g. programs, documents, sourcefiles etc.
Tip
If the File List window shows no files at all after a file search, of when you want to display all 
files in a directory or on a volume, have a look at the status-line. If it doesn't say 'All entries',
the empty display might be caused by the fact that you have selected a function class which
filters out all entries.    



Utilities Menu
Provides options to copy file-descriptions to, and paste them from, the clipboard and to print 
the contents of the File List window.
Options :

Copy to ClipBoard, Run Editor, Paste from ClipBoard
Print



Directory List window
This window shows all directories on the selected disk, together with the number of files and 
used diskspace per directory.
Click on any button, menu or field to see a description of it's function :



Size
This column shows the total size of all files in each directory.



Number of files
This column shows the number of files in each directory.



Directory-name
In this column, you'll see the name of every (sub)directory (if you have selected the 'Tree 
List' layout on the 'Customize Directory List' window), or every directories' full pathname.



Mouse Functions
Click the left mouse-button once on a directory-entry to select that directory.
Double-click the left mouse-button on a directory-entry to display all files in it on the File List 
window.



Close window
Clicking this button will close the Directory List window.



Select directories
You can limit the directories displayed to those that contain a certain string : enter the string
to look for on this field (or select it again from the drop-down list) and click the OK button on 
the right.
Click the CANCEL button on the right to display all directories again.
Note : if you select directories, the Directory List will always be displayed with full 
pathnames, because in this situation a tree list cannot be shown. 



Catalog Statistics window
The 'WinCat Statistics' window displays :

File Statistics :
- the total number of volumes and files;
- the total amount of used and free space.
This information is shown for all disks in the catalog, and for those that are part of the 
currently selected group.

Catalog Statistics :
- the name, size, creation-date and last update date of the currently open catalog;

Memory Statistics :
- the total amount of memory Windows has available for applications (in megabytes);
- the free percentage GDI and USER resources.

Evaluation period expiration date :
Only applicable when using an unregistered copy of WinCat ; it displays the date the 
evaluation period ends.    If you still use WinCat after this date, you should register it.



Open Catalog
Clicking the 'Open...' option on the 'File' menu will display the 'Open or Create Catalog' 
dialog, where you can select the catalog you want to use.

To create a new catalog, enter the name of a nonexistent catalog (with extension .CAT) and 
click OK. WinCat then asks if you want to create a new catalog.

As a default, the 'Open Catalog' dialog initially displays the directory you defined as 'Working
Directory' on the Programmanagers' 'Program Item Properties' window.
You can override this default by specifying the directory to display on the 'Catalog Directory' 
option on the Configure window.      

You can also let WinCat open a specific catalog automatically when you start WinCat.      



Save Catalog
Clicking the 'Save Catalog...' option on the 'File' menu will save all updates you made to the 
currently open catalog.

WinCat first saves a backup of the original catalog (*.BCK), and then creates a new catalog 
with extension .CAT.



Save Catalog As
Clicking the ''Save Catalog As...' option on the 'File' menu will display the 'Save Catalog As' 
dialog. 

Enter the name of the catalog you want to create (with extension .CAT) on this dialog and 
click OK.
WinCat will then save all updates you made to the currently open catalog in the new catalog.



Save Group As
Clicking the ''Save Group As...' option on the 'File' menu will display the 'Save Group As' 
dialog. 

With this function you can create a new catalog that contains only the volumes that you've 
selected with the 'Select Group' function.

Enter the name of the catalog you want to create (with extension .CAT) on this dialog and 
click OK.
WinCat will then save all information regarding the currently selected group of volumes in 
the new catalog.



Exit
Clicking the 'Exit' button on the Volume List window (or 'Exit' on the 'File' menu, or 'Close' on
the system menu) will end WinCat.

If there are any updates in the currently active catalog that haven't been saved yet, WinCat 
will ask you if these updates should be saved before actually ending WinCat.

Replies :
YES : all updates will be saved, and WinCat ends.
 NO : WinCat will end without saving updates.
Cancel :    Ignores the exit command.



1..5
WinCat displays the 5 last catalogs you used on the 'File' menu ; you can immediately open 
one of these by selecting them on this menu.



Configure window
Clicking the 'Configure' option on the 'Options' menu will display the Configure window, 
where you can specify WinCat's options and default settings.
Click the OK button to activate the selected options, and to save them in file WINCAT.INI.

Editor to use
Specify which editor you want WinCat to use, for instance when displaying the output
of the Print function.
Enter a full path/filename, like C:\WINDOWS\PROGRAMS\MEGAEDIT.EXE or D:\
EDITOR.EXE.
The default is C:\WINDOWS\NOTEPAD.EXE

WUNA
Specify which program to run when clicking the WUNA button on the 'Restore File' 
window.
Enter a full path/programname (and optional parameters), like this :
C:\PROGRAMS\WUNA.EXE -p<
Default : WUNA -p<

WinZip
Specify which program to run when clicking the WinZip button on the 'Restore File' 
window.
Enter a full path/programname (and optional parameters), like this : 
C:\PROGRAMS\WINZIP.EXE
Default : WINZIP

Archive Contents Directory
Specify where you want WinCat to save it's .ACT files when cataloging the contents of
archive-files on a disk.
Enter a full pathname, like C:\WINDOWS\MYDATA or D:\BACKUP\DATA\.
The default is C:\WINDOWS\WINCAT\ARCHIVES

Default Catalog Directory
This is the directory WinCat will initially display on the 'Open Catalog' window.
The default is the 'working directory' you specify on the Programmanagers 'Program 
Item Properties' window.

Initial Restore Directory
This is the target directory that WinCat will initially select for restoring files.
Specify the name of an existing directory, like C:\RESTORE or D:\TRASH\.
The default is C:\

Date format
Specify which data format you want WinCat to use when displaying dates.
You can chose between the formats 'DD-MM-YY' (also known as the normal format...) 
or 'MM-DD-YY' (the American way). 
The default is DD-MM-YY.

Scan 4DOS descript.ion file when cataloging a disk



Specify whether or not you want WinCat to copy file-comments from a 4DOS 
descript.ion file (if present) when cataloging a disk.
The default is YES

 Replace existing description with those from the descript.ion file
Specify whether or not you want WinCat to replace existing filecomments with those 
that are in the descript.ion file.
The default is NO

Catalog contents of ARJ, ZIP, LZH, ZOO, ARC and PAK archives.
Specify whether or not you want WinCat to catalog the contents of archive-files when 
cataloging a disk.
The default is NO

Display Recatalog window when recataloging a disk.
When you catalog a disk that's already present in the catalog, you can let WinCat 
display a Recatalog window that shows the differences between the information in 
the catalog, and the actual contents of the disk by enabling this option.
The default is YES

Write volume-label on disk if changed
When you enter or alter a floppydisk's Volume-ID on the 'Catalog Disk' window, you 
can let WinCat write this new ID as a volume-label on the disk by checking a 
checkbox on the 'Catalog Disk' window.
Here you can specify the initial setting of that checkbox.
The default is NO.

Display Volume Information window
If you select this option, WinCat will display the Volume Information window when a 
disk has been cataloged ; on the Volume Information window you can then enter the 
disk's description and group ID's.
The default is YES.

Auto-save catalogs
If this option is set, WinCat will save updated catalogs automatically when opening 
another catalog, or when ending WinCat.
The default is NO, which means that WinCat will ask if the catalog should be saved.
Note :    use this option with caution !

Display toolbar on Volume- and File-List windows
If set, WinCat will display toolbar-buttons for the most frequently used functions on 
the Volume List, File List and Archive-file List windows.
The default is YES. 

Language
Select in which language you want WinCat's menu's, pop-up-menu and help-
messages displayed : English, French, German or Dutch. 
The default is English.



Select Volume Group window
With the 'Select Group' function you can limit the volumes displayed on the Volume List 
window to those belonging to the selected group, location or owner. 
You can also select a group of volumes with a minimum amount of free space, volumes of a 
certain disktype (e.g. all 3.5" 1.44 MB disks) or volumes that have a certain string in their 
description field.

This can be useful when you have a lot of disks in your catalog : instead of scrolling through 
a long list of volumes on the Volume List window, you can use the 'Select Group' function to 
select for instance only those disks that contain Windows programs or games, only those 
disks that belong to owner John or only those disks that have more then 300K free space.

Note : when you select a group,    ALL(*) WinCat functions (like search, print, import, export 
etc.) will operate only on (files on) volumes belonging to that group.

This means that if you have selected volume group 'Windows' and want to search for files 
with string 'driver' in their comment field, WinCat will show only those files that reside on 
one of the volumes that belong to the selected group 'Windows'. 

(*)    Only exception : the 'Save Catalog (As)' function ignores groups ; the catalog will always
be saved in it's entity, regardless of whether or not a group is selected. 



Display Tagged Files
Clicking the 'Display Tagged Files' option on the 'Options' menu will display the File List 
window, showing all files you tagged with the TAG function.



Reset File Tags
Clicking the 'Reset File Tags' option on the 'Options' menu will clear all files TAGs.



Compare window
Clicking the 'Compare' option on the 'Utilities' menu will display the 'Compare' window.

You can use this function to let WinCat compare the contents of a directory on your harddisk,
or the contents of a floppy disk, with the information in the catalog.
So you can easily see whether or not files are cataloged, and if so on which volume(s) they 
reside.

First select the disk or the directory you want to check against the catalog, and click OK.
WinCat will first sort the catalog, and then shows which files from the selected disk or 
directory are present in the catalog. 



Import window
Use this function to import file-descriptions from BBS AllFiles listings, listings from other 
(???!) disk catalog programs, 4DOS descript.ion files, CompuServe *.CAT listings etc.
This is the way to do it :

1) Select the text file to import descriptions from.
This must be a 'normal' ASCII text file, that is each line must end with a hex '0D0A' line 
delimiter.

2) Specify whether you want WinCat to replace existing file-descriptions with the imported 
ones by clicking the appropriate checkbox.

3) Specify whether or not you want WinCat to take filename-extensions into account when 
comparing filenames from the textfile with those from the catalog.
If you set this option to 'YES', WinCat will ignore extensions and so will consider file 
'SAMPLE.ARJ' to be the same as file 'SAMPLE.ZIP'.

4) Specify the number of words to drop between filename and description :

A typical line in an AllFiles listing may look like this :

WINCAT34.ARJ    420200    01-03-94    [899]    SPLENDID Disk Catalog for Windows

Obviously, only the text 'SPLENDID Disk Catalog for Windows' should be taken as the 
description for WINCAT34.ARJ.
To do this, you must tell WinCat how many words to drop from the text following the 
filename WINCAT34.ARJ. In this example, the first 3 words (strings delimited by one or more 
spaces, in this example 420200    01-03-94    [899] ) after WINCAT34.ARJ should be dropped, 
so the number to specify is 3.

5) Specify textfile format :

Single-line entries
This is the most common format for BBS AllFiles listings : each line in the textfile starts with 
a filename, followed by the file's description.
The lines in the textfile must have the format 'Filename.Ext    Text'.
The filename may be in uppers or lowercase, and may be preceded by spaces.    
WinCat ignores lines that don't adhere to this syntax.

CompuServe *.CAT listing
CompuServe supplies *.CAT listings (in TAPCIS format), where the description for each file 
looks like this :
[72230,1451]    Lib: 1
FLAG.ZIP/Bin    Bytes:  18501, Count:  107, 15-Aug-92(18-Aug-92)

  Title   : Batch Porting Tool for Win 3.X to Win32 ports.
  Keywords: PORT PORTING TOOL WIN32

WinCat locates every filename in a .CAT listing (FLAG.ZIP in this example), and copies the 



description from the corresponding Title field to it's catalog.

When you click OK, WinCat will first sort the files in the catalog (or in the current active 
group), and then scan the selected textfile.
For each filename found in the textfile WinCat will check whether a file with this name exists 
in the catalog. If so, WinCat will copy the description that follows the filename (in the 
textfile) to the 
corresponding file in the catalog, and set that file's TAG.

After WinCat has finished reading the textfile he'll display the 'Files' window, showing all 
(TAGged) files that were updated.      
If you're not completely happy with the result you can use [COPY], [EDIT] and [PASTE] to 
change things.



Export window
Clicking the 'Export' option on the 'Utilities' menu will display the 'Export' window. 

This function exports the information in the catalog (or in the current active group) to a file 
in DBF format. The .DBF file can be used with database products like dBase, Paradox, Excel 
etc.

WinCat will create a record in the .DBF file for each file in the catalog or group. Apart from 
the name of each file (which is always part of a record) you can select additional fields you 
want included in
each record : volume id, directory, date, size and/or comment. 



Printing Reports
Clicking the 'Report' option on the 'Utilities' menu will display these five options :

Options
Displays a window where you can select the fields you want included on the reports to print.

Volume Summary
Creates a summary listing of all volumes.

Volume Contents
Creates a listing of all volumes and their contents.

Files sorted by Filename
Creates a sorted listing of all files in the catalog.

Duplicate Files
Creates a listing of files that occur more than once in the catalog.

Archive Contents
Creates a listing of all files in archive files.

When printing a report (either by using the 'Report...' option on WinCat's main menu, or by 
clicking the 'Print' button on a listbox), WinCat displays a window where you can :

- cancel the print
- select the print destination (either to file WINCAT.LST, or directly to your printer)
- indicate you want to edit the listing (if you select 'File' as destination) after it has 
been created.



Print Disklabels
Clicking the 'Print Disklabels' option on the 'Utilities' menu will display the 'Print Disklabels' 
window.
This window doesn't actually print the labels ; it just creates a file (WOODLE.INP) that serves 
as input for the WOODLE utility.

First select the volumes you want to print a label for ; after doing so, click the 'Create 
WOODLE.INP' button.
WinCat will then create the input-file file for WOODLE, and will ask you whether you want to 
run the WOODLE Disklabel Editor to select a label-layout and to print the labels.



Registering WinCat
WinCat/PRO is not free software. If you use this software after the 21 day evaluation period a
license (with a registration fee of 15 US dollars) is required. 
Paying the registration fee entitles you to use WinCat/PRO version 3.4, and all other 
subsequent 3.x releases that may be distributed.

Two types of licenses are available : the one for personal use, and the multi-workstation 
license for company use.

 License for personal use :

This license can be transferred freely from machine to machine as long as there is no chance
that it is ever in use on more than one machine.
You are encouraged to share your evaluation copy of WinCat, but you may not distribute 
registered copies or registration numbers under any circumstance.
The registration number (which disables the AidWare notices that appear when opening a 
catalog, and when ending WinCat) will be sent to you immediately after I've received the 
registration-fee.

Please read : How to order a Personal License

 Multi-workstation or site-license :

For companies, public services and other organizations multi-workstation site licenses are 
available.

The multi-workstation license allows you to install and use the registered copy of 
WinCat/PRO 3.x on as many workstations as stated on the license-agreement.
If you install WinCat/PRO on a LAN server-station, you're allowed to use it from as many 
workstations as stated on the license-agreement.
You may not distribute your registered copy of WinCat/PRO to, or use it on, workstations that
aren't used by employees of your company.
You can always upgrade your existing license for use on more workstations ; the required fee
will be the difference between the normal fee for the new license and the fee you already 
paid.

Please read : How to order a Site License



How To Order Your Personal License
You can order your WinCat license either directly from the author, OR from the American 
Public (software) Library.

1. Ordering a WinCat Personal License from the author :
Send the WinCat orderform (and optionally the questionnaire) plus the required 
registrationfee to :
Mart Heubel
De Heugden 161
6411 DR    Heerlen
The Netherlands

(Note : orders from outside Europe generally arrive at the author within a week if sent by 
airmail).
 
Choose one of these methods to pay :

Money 
Order

Enclose US$15.00 or HFl. 25,00 in cash (bills, no check) with the 
orderform.
US dollars or Dutch Guilders are preferred, but (if the bank 
charges you an outrageous fee for changing currency) the 
equivalent amount in any other currency will be accepted too.

Giro Maak HFl 25,00 over op de postgiro-rekening van :
M.B.M. Heubel
Rekeningnummer 4086382
O.v.v. 'Licentie WinCat/PRO'
Note : This method is applicable to Dutch users only ! 

EURO-Check Enclose an EURO-Check worth HFl 25,00 with the orderform.
Please make sure you have signed the check, and don't forget 
to enter the number on the back of it !
Note : this method is applicable to European users only !

Note 1 : American, Canadian, Australian etc. checks/cheques are NOT 
accepted !
The reason for this is that the transaction-costs charged by the banks 
to either or both you and me are so outrageous that they are almost 
ridiculous : they vary from $9 to $30 (yes, thirty !!),    and seem to 
depend on the mood of the bankemployee and the weather.
So, if you are not a European user :    please don't send a check ; all I 
can do with it is tear it up.
Consider sending plain cash (dollar bills), or register using your credit 
card by calling the Public (software) Library (see below).

Note 2 : The author can NOT accept registration by credit card !
If you want to register using your credit card, please call the Public 



(software) Library (see below).
Note 3 : All prices include postage to send your license worldwide.
Note 4 : In order to keep WinCat's price as low as possible and to maximize 

WinCat's revenue (by reducing overhead-costs to a minimum), the 
author sends you a license plus registration number only ; a disk, 
a 4-color glossy manual or other unnecessary stuff is NOT included 
(and not available) !              

2. Ordering a WinCat Personal License from the Public (software) 
Library :

You can also order your WinCat Personal License from the American Public (software) Library 
with your Visa, MasterCard, American Express, or Discover credit card by calling:

800-2424-PSL (toll free within the United States), 

or 713-524-6394 (when calling from outside the USA),

or by FAX to 713-524-6398,

or by CompuServe to 71355,470
- request WinCat/PRO registration, Item Number 10966

- the total registration-fee when ordering by creditcard from PsL is US $20.00 
($ 15.00 license-fee plus $5.00 PsL handling-fee). 
This price includes postage to send your license worldwide.

IMPORTANT INFORMATION FOR CREDIT CARD CUSTOMERS:    
Credit card registrations for WinCat/PRO are handled through the Public (software) Library's 
ShareWare Registration Service.
PsL will notify the author the day of your order. Your license will then be shipped by the 
author within 24 to 48 hours.
Please note that the numbers listed above are for ORDERING ONLY !
The author can NOT be reached at those numbers ; please read Your Comments Please for 
information about how to contact the author. 

When ordering a WinCat/PRO license from PsL, the same conditions apply as when ordering 
directly from the author :
* by registering WinCat/PRO you acknowledge and consent to the disclaimer of warranty 
* you also acknowledge and accept that your registration-fee will be donated to the Dutch 
Foster Parents Plan organisation, and therefore under no circumstance, totally nor partially, 
can nor will be refunded.
* In order to keep WinCat's price as low as possible and to maximize WinCat's revenue (by 
reducing overhead-costs to a minimum), the author sends you a license plus registration 
number only ; a disk, a 4-color glossy manual or other unnecessary stuff is NOT included 
(and not available) !





How To Order A Site License
Site licenses can only be ordered directly from the author. 

The following prices apply to site licenses for use on...

up to 5 workstations US$        50.00    (HFl. 100,00)
up to 10 workstations US$        75.00    (HFl. 150,00)
up to 25 workstations US$ 125.00    (HFl. 250,00)
up to 50 workstations US$ 200.00    (HFl. 400,00)
up to 100 workstations US$ 300.00    (HFl. 600,00)
more than 100 
workstations

- please contact the author -

If you order the 'up to 5 workstations' or 'up to 10 workstations' license, the registration 
number (which disables the AidWare notices) will be sent    to you immediately after I've 
received the registration-fee.

Starting with the 'up to 25 workstations' license you'll receive a disk with an adapted version
of WinCat/PRO :

* It doesn't need a registration number;
* The 'Hall of Fame' window will be replaced by a 'Registered to...' window, which

displays your company's name and, if you supply the appropriate graphic in 
BMP format, your company's logo. Optionally, you can also have a logo on 
WinCat's main window (instead of the WinCat/PRO logo);

* You will also automatically receive any new release of WinCat 3.x on disk, 
again with your company's name and optional logo included.

The disk with the adapted version of WinCat 3.x will be sent to you immediately after I've 
received the registration-fee.

Choose one of these methods to pay :

Giro Betaling door overmaking van de licentie-kosten op de 
postgiro-rekening van :
M.B.M. Heubel
Rekeningnummer 4086382
O.v.v. 'Site Licentie WinCat/PRO voor ... werkstations' 
Note : This method is for Dutch users only ! 

EURO-Check Send one or more EURO-Checks that cover the required 
registration-fee along with your order.
Please make sure you have signed the check(s), and don't 
forget to enter the number on the back of it/them !
Note : this method is for European users only !

Check Send one or more Checks that cover the required registration-



fee plus $9.00 handling fee along with your order. 
Check(s) should be made payable to : M. B. M. Heubel 
Note : this method is for non-European users only !

Note 1 : Because of the amounts involved when ordering a site license 
by sending checks, I strongly advise to send your order as a 
'Registered Letter' (aangetekend / lettre recommande) to the 
author.    

Note 2 : Please contact the author before ordering a 'up to 25 
workstations' or up site license, in order to make arrangements 
for payment and to discuss your requirements for adding your 
company's logo in WinCat. 

Note 3 : Unfortunately, the author cannot accept credit card orders.



WinCat/PRO 3.4 Orderform
(click the Print Topic option on the File menu to print this form)

YES, I would like to support the AidWare project by registering WinCat/PRO, so I hereby 
order my own personal license !

The registration-number that I will receive entitles me to use WinCat/PRO version 3.4, and all
other subsequent 3.x releases that may be distributed.

I will pay the required registration-fee by/with (please check) :

Money 
Order

Enclose US$15.00 or HFl. 25,00 in cash (bills, no check) with this 
orderform.

[      ] US dollars or Dutch Guilders are preferred, but (if the bank charges you 
an outrageous fee for changing currency) the equivalent amount in any 
other currency will be accepted too.

Giro Maak HFl 25,00 over op postgiro-rekening 4086382 
[      ] tnv. M.B.M. Heubel,    ovv. 'Licentie WinCat/PRO' 

Note : This method is applicable to Dutch users only !

EURO-Check Enclose an EURO-Check worth HFl 25,00 with this orderform.
[      ] Please make sure you have signed the check, and don't forget to enter 

the number on the back of it !
Note : this method is applicable to European users only !

Note 1 : American, Canadian, Australian etc. checks/cheques are NOT accepted because of 
huge transaction costs.
Consider sending plain cash (dollar bills), or register using your credit card by calling the 
Public (software) Library.

Note 2 : All prices include postage to send your license worldwide.
Note 3 : In order to keep WinCat's price as low as possible and to maximize WinCat's revenue (by 

reducing overhead-costs to a minimum), the author sends you a license plus registration 
number only ; a disk, a 4-color glossy manual or other unnecessary stuff is NOT included 
(and not available) !              

Send my license and registrationnumber to :

Name Mr/Mrs/Ms........................................................................

Address ............................................................................................

............................................................................................

............................................................................................

............................................................................................

By registering WinCat/PRO I acknowledge and consent to the disclaimer of warranty as



stated in WINCAT.HLP.
I also acknowledge and accept that my registration-fee will be donated to the Dutch Foster 
Parents Plan organisation, and therefore under no circumstance, totally nor partially, can nor
will be refunded.

Date      : ...............                              Signature : ..................................



WinCat/PRO Questionnaire
(click the Print Topic option on the File menu to print this form)

In order to continue to improve WinCat the author would really like to know a few things 
about your computer equipment, how you use WinCat and of course what you think of 
WinCat.
So please take a minute to answer these questions, and send this questionnaire along with 
the orderform.

What type of CPU do you have ?
O 286- O 386- O 486- O SX O DX O 586/Pentium

What is the speed of your CPU (in megaHertz) ?
O < 25 O 25 O 33 O 40 O 50 O 66 O ....

What is the amount of memory in your system (in megabytes) ?
O 1 O 2 O 4 O 6 O 8 O 16 O ....

Which operating system do you use ?
O DOS 5.0 O DOS 6.x O 4DOS O DR-DOS O NDOS O ...................
and/or

O Windows 3.1 O Windows 4.0 O Windows for 
Workgroups

O Windows NT O OS/2 O ....................

Which display-mode do you use mostly ?
O EGA O VGA O SVGA O ................................
using display-resolution

O 640x480 O 800x600 O 1024x768 O ................................
colors :

O none O 16 O 256 O 32768 O .........................

Which disk-drives do you use ?
O 3.5" floppy O 5.25" floppy O CD-ROM O Magneto-Optical
O Tape O Bernoulli O.....................

Can you give an estimate of how many disks/files you're going to catalog with WinCat ?
FloppyDisks : ______ / ______
CD-ROMS : ______ / ______
Other : ______ / ______

Where do you use WinCat ?
O At home O At work O Both

Which disk catalog program (if any) where you using previously or have you tried ?
O CatDisk O SmartCat O DiskTrak O DiskMan
O WinCat 2.x O IntelliCat O ...................

Where did you get your copy of WinCat ?
O Bulletin Board System O from a friend O ShareWare disk/CD : .................................................



O Public (software) Library O CompuServe O....................................................................................

Your verdict please : on a scale from 1 (utterly lousy, it stinks etc.) to 10 (excellent, out-of-this-world etc.), how
would you rate :

- The overall impression WinCat makes ______
- WinCat's speed ______
- WinCat's features and functions ______
- WinCat's graphic user interface ______
- WinCat's WOODLE disklabel print utility ______
- Ease of use ______
- The WinCat On-line Help ______

What do you like best in WinCat ?

What do you definitely DON'T like in the current WinCat release ?

Which feature(s) or function(s) would you like to see in a new release of WinCat ?



Entering Your Registration Number
Clicking the 'Register' option on the 'Help' menu will display the 'Register WinCat' window, 
where you can enter your name and the registration-number that's listed on your license-
agreement.

When you send me WinCat's orderform (plus the money of course...), you'll receive a 
registration-number that disables the AidWare windows that appear when opening a catalog 
and when ending WinCat.

This unique registration-number was generated by a fractal generator that takes your name 
as input and (after 3 minutes calculating on a 486-66), spits out an 8 to 10 digit number 
(believe me, even I don't know how this actually works).
    
So, to register WinCat you must enter your name and the registration-number exactly as 
stated on the license-agreement, because WinCat will check the number against the name 
(surprisingly, this takes almost no time at all... but then, I don't know how this works either).
If WinCat detects that the name and number don't match, registration will fail.
If you enter the correct name and number, WinCat will say 'thanks for registering !', and 
your name will appear on the WHOF window.

Note : to enter national language characters like ü, ö and æ you must enter the character's 
ASCII code. For instance, to enter the character ü you must press the ALT key and enter 
0252.
The Windows' Character Map program (CHARMAP.EXE) shows which code corresponds to 
which character.

WinCat saves your name and the registration-number in file WINCAT.INI. If, for some reason, 
this file gets accidentally erased you must reenter your registration. So don't throw away the
license-agreement once you've registered, as you might need it again in the future !



About AidWare
WinCat/PRO is offered as 'AidWare' : if you use WinCat/PRO, you must register it.      

But relax, this won't cost you an arm and a leg : to encourage people to register I offer 
WinCat at a bargain price, compared to commercial packages that cost at least twice as 
much (and that don't have even half of WinCat's features...). So, with kind regards to 
WinCat's competitors :      

The registration-fee for a personal WinCat/PRO license is US$ 15.00 / Hfl. 25,00.

ALL THIS FOR A LOUSY FIFTEEN BUCKS ?

Yep. Well, it may be peanuts to you and me, but in some parts of the world 15 bucks can 
make the difference between life and death. If this fact comes as a shock to you I suggest 
you watch the evening news once in a while...

That's why I'll donate every received registrationfee to the Dutch Foster Parents Plan (FPP) 
organization, a member of Plan International.
(Plan International has branches in Australia, Belgium, United Kingdom, Canada, Germany, 
Japan, the United States and the Netherlands.)
FPP provides material and financial support to developmentprojects in so-called 3rd-world 
countries all around the globe. These projects involve children's education, agricultural 
development, providing medical care etc.

And believe me : it doesn't take billions to do something worthwhile.
For about US$ 4,000 they can build a little school ; with US$ 5,000 they can provide means 
so threehundred families can have fresh water every day.

One of the planned projects of FPP is to build a medical centre in the Kandi district on Sri 
Lanka.
Of course a project like this is a bit more expensive : US$ 70,000.
But, believe it or not : although I'll have to sell a -beep- lot of WinCat licenses to raise that 
kind of money : my goal is to raise enough funds to enable FPP to actually build this 'WinCat'
Medical Centre ! (with the cat logo on the front door, of course).

Maybe that's (as somebody once elegantly put it) 'dreaming the impossible dream'.
But then, what would life be without dreams...
And what's more : we're a worldwide community of over 10 million Windows users, and we 
all have the same (luxury) problem : a stack of floppy-disks and CD's... If I can get 1 of every
1000 of you to use WinCat (no problem I guess) and to pay for it (oops), WinCat Medical 
Centre becomes reality !

Wouldn't it be just great if we, WinCat users, actually managed to achieve this ? Come on, 
admit it, you too would be proud of this !

So, why not share the dream and make it come true : register WinCat !



(Hmm, I should consider going into politics writing demagogic stuff like this...)

By the way : in all subsequent WinCat releases I'll display a random selection of the names 
of people who registered on WinCat's 'Hall of Fame' window !
Imagine... your name on the silver screen... your friends will be AMAZED... your 
wife/husband/ girlfriend/boyfriend will (finally ?) respect you... and because WinCat is 
distributed through WIN*NET you'll become instantly worldfamous ! And if they publish 
WinCat on CD-ROM... IMMORTAL !!!

And all this for a mere 15 bucks... Definitely the best deal since Peter Stuyvesant (Dutch guy
too by the way) bought Manhattan from the Indians for 50 dollars and a bottle of gin !

PS.

 If you like WinCat : why not try to convince your boss that you desperately need it at work, 
and that it's really worthwhile to order a site-license ? (And to have your company's logo in 
WinCat !)

 If you like WinCat and the AidWare concept, and also know a way to get a review of WinCat
in a local PC magazine... well, need I say more ?

 If you're not interested in registering WinCat, but like the AidWare idea : donations are 
accepted with the utmost gratitude also !



About the Author
Mart Heubel popped into this world at a very cold December, 20 in 1961 in Maastricht, The 
Netherlands. It was 04:20 in the morning and, because his dad forgot to turn on the heating, 
FREEZING outthere. Ever since, Mart hated to get up early.    
Allthough very intelligent, Mart decided to keep a low profile during his schooldays. Years 
passed, and nothing remarkable happened.
At the age of seventeen, Mart had his first girlfriend. After a while, she dumped him and Mart
went to university to study electronics. After a while, they dumped him and Mart became a 
successfull mainframe systems programmer.

Currrently, Mart lives in Heerlen. When not working, he likes to ride his Italian Moto Guzzi 
motorbike and read Garfield cartoons.
Being an absolute Garfield addict, Mart's motto in life comes from one of those magnificent 
Garfield cartoons :

" Some people live exciting lives ; others seek romance and adventure. And the occasional 
lunatic writes a disk catalog program "



Important Notice
When using an unregistered version of WinCat, each catalog you create has it's own 
evaluation period of 21 days.
When this standard evaluation period has ended WinCat still allows you to use that catalog, 
but you'll receive an 'Evaluation period expiring !' message each time you open that catalog.

After entering your registration-number on WinCat's 'Register...' window, you won't be 
bothered with AidWare notices and nagging messages ever again.



Where to get WinCat

WIN*NET
WinCat is distributed through the international WIN*NET network, and so should be available
on every local Windows BBS that has a connection to WIN*NET.

ClipBoard BBS
You can always find the latest version of WinCat/PRO on the Dutch ClipBoard BBS ; the 
biggest Windows Bulletin Board in the Netherlands, specialized in providing the newest 
Windows ShareWare and Public Domain software.
You can reach ClipBoard BBS at : +(31)-(0)10-4820737
Network node of : Digital Net 15:1000/102

TechNet 111:313/114
Fido 2:285/821
WIN*NET ClipNet(tm)

SysOp : Mr. Peter Jansen

CompuServe
The latest version of WinCat/PRO will also be available on CompuServe : go to forum 
WINSHARE and look in library Disk Utilities.

Public (software) Library
You can also order a disk with the latest version of WinCat/PRO from Public (software) Library
; please look in their latest ShareWare catalog for details.

CICA (Internet)
Users that have a connection to the Internet network can do an anonymous filerequest from 
node
CICA.ftp.

CD-ROM
Good chance you'll find WinCat/PRO on CD-ROMs containing Windows shareware programs, 
for instance CICA MS-Windows, WinWare, etc..
Nevertheless, if you can't find WinCat on a shareware CD you bought : get very angry, call 
the supplier and ask him why the f*ck they didn't include it... ;-)





Your Comments...
If you discover serious bugs in WinCat, or if you have any "wouldn't it be nice if WinCat ..." 
ideas, feel free to drop a message in my mailbox at CompuServe Mail 72066,2116, or send a
message to me at ClipBoard BBS.

But : please keep in mind that WinCat isn't a product of a multimillion dollar revenue 
company that employs an impressive technical staff ; WinCat is just a product of some poor 
sod (me) who, during times other (normal) people like to go out, eat, have sex, sleep and/or 
in any other way have a jolly good time, likes (?) to spend his scarce spare time gazing at his
PC-screen in order to develop and promote and support and debug and push and market and
test and improve and sell and document something that LOOKS like it has been developed 
by a multimillion dollar revenue company that employs an impressive technical staff...
In other words : WinCat already takes up a lot of my time, so please don't be offended if I 
don't answer a message, or if it takes a while before you receive an answer. 



Distributing WinCat
The following applies to noncommercial distribution only ; distribution is 
noncommercial if it is for free, or by a hobby, user or computer interest group to its 
members, or by any BBS (including CompuServe, CIX and Internet networks).
For terms and conditions that apply to any other kind of distribution, refer to the Vendor 
Information section.

The evaluation-copy of WinCat/PRO (i.e. the original WinCat/PRO package without the 
registration number) may be freely copied and distributed on a noncommercial basis as long
as the following conditions are met :

[1] You may not distribute registered copies or registration numbers under any 
circumstance.

[2] No fee is charged other than a normal time usage fee required by some Bulletin Board 
Services, or a fee for media- and distribution-costs, not to exceed US$ 4.00 per disk.

[3] The program and it's associated files are distributed in their original, unmodified form.

[4] All document files are included with the executable files without modification.



Vendor Information
This section contains sample descriptions for catalog, library, or BBS use, requirements for 
commercial distributors, and other information.

Suggested one-line program description :

WinCat/PRO Disk and CDRom Catalog/FileManager

Suggested keywords :

WinCat Windows DiskCatalog Catalog FileManager Disk CDRom Utility AidWare

Suggested description :

WinCat/PRO Disk and CDRom Catalog : to boldly go where no cat has gone before !
WinCat/PRO brings order in your growing collection of files on floppydisks, CDRom's, 
harddisks etc.
It's easy to use, yet powerful, fast (Turbo Pascal) and offers you splendid graphics.
Because WinCat/PRO interfaces to all DOS/Windows programs (like WinZip), you can easily 
restore, extract, run, edit etc. any file with a single mouseclick.
WinCat/PRO optionally catalogs the contents of ZIP, ARJ, LZH, PAK, ARC and ZOO archive 
files.
Features : extensive search/sort/view capabilities, imports file-descriptions from text-files, 
4DOS descript.ion files etc., exports to DBF compatible file, various user-configurable 
reports, WOODLE disklabel printer with convenient WYSIWYG editor.
Distributed as AidWare : all registration-fees will be donated to the Dutch Foster Parents Plan
organization, in order to support their activities in development-countries.

System requirements :

Hardware : at least 4MB RAM, 2MB diskspace
Software : Microsoft Windows 3.1
Recommended : Mouse or other pointing device 

: WinZip ((c) Nico Mak Computing, Inc.) for extracting archive files
Optional : High-quality (Laser-, Jet-, Bubble-) printer for printing disklabels.

Registration :

Registration-fee for a single Personal License is US$ 15.00.
(includes postage to send license worldwide, disk NOT included).

Author :

Mart Heubel, De Heugden 161, 6411 DR    Heerlen, The Netherlands

Commercial Distribution License Agreement :

The terms below outline requirements for commercial distribution. "Commercial distribution"



or "commercially distribute" means to distribute for gain (such as, but not limited to, via 
traditional shareware catalogs, shareware packages, trade shows, or rack vending).
This file will inform the potential commercial distributor as to whether or not they have been 
automatically granted such a license for their type of distribution (if not, special written 
authorization is required). Other important information is also presented.

The Distribution License Agreement applies to distribution of the WinCat/PRO shareware 
evaluation version only ; distribution of registered copies of WinCat/PRO or WinCat/PRO 
registration-numbers by any vendor, individual, group or entity is explicitly prohibited.
            
This is an agreement between you (either an individual or an entity) and the author. By 
commercially distributing copies of the shareware evaluation version of WinCat/PRO, you are
agreeing to be bound by the terms of this agreement.
If you do not agree to the terms of this agreement, you may not distribute the shareware 
evaluation version of WinCat/PRO.

COPYRIGHT : The shareware evaluation version of WinCat/PRO (hereafter, "the 
SOFTWARE") is Copyright (c) 1992-1994 by Mart Heubel (hereafter, "the author") and is 
protected by Dutch copyright laws and international treaty provisions. The author, as 
exclusive publisher, is an authorized representative of the copyright holder. Except to the 
extent expressly licensed, the copyright holder has and reserves the exclusive copyright and
other right, title, and interest to    copy and distribute this software, and the right to use the 
Trademark "WinCat/PRO" in connection with it.

DISTRIBUTION VIA CATALOGS : Catalog vendors are automatically granted a license to 
distribute the SOFTWARE via their catalog for a fee provided they agree to abide by the 
following terms:

[1] A copy of the first catalog or listing advertising the distribution of the 
SOFTWARE will be sent to the author.

[2] The catalog or listing must contain a statement to the effect that the 
SOFTWARE is not free, and that additional payment to the author/publisher 
is required after a stated evaluation period. (The standard statement 
required by the Association of Shareware Professionals is sufficient.)

[3] Updated versions of the SOFTWARE sent to the distributor will be reflected 
in what is distributed and advertised in the catalog or listing as soon as 
possible.

DISTRIBUTION VIA CD-ROM : CD-ROM vendors are automatically granted a license to 
include the SOFTWARE on Shareware compilation CD-ROMs to be distributed for a fee, 
provided they agree to abide by the following terms:

[1] The CD-ROM package must contain a statement to the effect that the 
SOFTWARE is not free, and that additional payment to the author/publisher 
is required after a stated evaluation period. (The standard statement 
required by the Association of Shareware Professionals is sufficient.)

[2] Updated versions of the SOFTWARE sent to the distributor will be reflected in
what is distributed as soon as possible.

ALL OTHER TYPES OF DISTRIBUTION (RACKS, PACKAGES etc.) :
Distribution of the SOFTWARE using any other method (for example: via rack vending 
methods, sale in a retail store, sale at a trade show, as part of some more inclusive product 



or service) requires special written authorization from the author, which may be subject to 
special licensing terms.
No vendor, individual, group, or entity has a license to distribute the SOFTWARE using any 
other method without special written authorization from the author.
(NOTE: "as part of some more inclusive product or service" does not refer to distribution via 
any type of BBS or the practice by certain catalog/CD-Rom vendors of offering several 
programs on a single diskette/CD-Rom or in a set of multiple diskettes.)

REGISTRATION SERVICES : Without special written authorization from the author, no 
vendor, individual, group, or entity is authorized to provide a registration service for the 
SOFTWARE or to handle registrations for the SOFTWARE on behalf of the author.
 
MODIFICATIONS : The SOFTWARE package may not be abridged or otherwise modified in 
any way.
(NOTE: This does not refer to the addition of installation, informational, or advertising files by
catalog/CD-Rom vendors.)

REVOCATION OF LICENSE : The license to distribute the SOFTWARE can be revoked from 
any vendor, individual, group, or entity at any time for any reason on 30 days advance 
written notice.

DAMAGES : Distribution of the SOFTWARE without a license to do so is explicitly prohibited.  
Liquidated damages for unauthorized distribution shall not be less than $5.00 (in U.S. funds) 
for each individual copy of the SOFTWARE that is sold or transferred by the vendor, 
individual, group, or entity without a license to do so.

DISCLAIMER OF WARRANTY : See Disclaimer of Warranty



Copyright Notice

WinCat/PRO TM

(c) 1992-1994 by Mart Heubel

WOODLE TM

(c) 1993-1994 by Mart Heubel

All rights reserved

The WinCat/PRO and WOODLE software is owned by the author (Mart Heubel,
Heerlen, The Netherlands) and is protected by national copyright laws and 
international treaty provisions.
Copies of the WinCat/PRO and/or WOODLE programs and/or any of their 
associated files remain property of the author.
Except to the extent expressly licensed, the copyright holder has and reserves the
exclusive copyright and other right, title, and interest to copy and distribute this 
software, and the right to use the Trademark "WinCat/PRO" in connection with 
it.



Disclaimer of Warranty
By using and/or registering WinCat/PRO you acknowledge and consent to the following

DISCLAIMER OF WARRANTY :
                  
WinCat/PRO, including all related programs, texts, and files, is supplied "as is". The author disclaims all warranties, 
expressed or implied, including, without limitation, the warranties of merchantability, compatibility now or in the 
future with any configuration of computing equipment or software, or of fitness for any purpose.
The author assumes no liability for damages, direct or consequential, which may result from the normal use or abuse
of WinCat/PRO and related programs.
The author specifically and categorically disclaims responsibility for damages, direct or consequential, resulting 
from installation or use of WinCat/PRO or related programs or files which have been distributed after any 
modification - either deliberate or unwitting - by any party other than the author, or distributed in any fashion that 
would otherwise violate the terms of this license.

If you do not agree to the terms in this agreement, you must cease using and/or distributing WinCat/PRO 
immediately. 



Welcome to WinCat !
WinCat is a tool that helps you organize your floppydisks and CD-Rom's, and enables you to 
quickly find and restore the files they hide.

Although there are various disk catalog programs around, none of them really suited my 
needs or taste.    Therefore I decided to write my own (always a guarantee for quality 
software !), and the result of a few weeks fooling around with Visual Basic and Turbo Pascal 
was WinCat 1.0.
In little then a year this initial release evolved into a rather useful tool (WinCat 2.5), but it 
also became clear that -due to the Visual Basic programming language- further 
improvements like CD-ROM support were almost impossible to realize without slowing down 
the program to a snail's speed.

That's why I wrote an entirely new version of WinCat using Borland's Turbo Pascal for 
Windows. This new WinCat/PRO is the successor to WinCat 2.5, but although it looks a lot 
like the old WinCat 2.5, there's one big difference : it's very, VERY fast !

Because of all it's features and it's speed I humbly consider WinCat/PRO to be the best 
floppydisk/CD-Rom manager available for Windows today (with WinCat 2.5 being a good 
second best...).

So here's the 'bad' news :
WinCat/PRO is distributed as AidWare and is NOT free (but at $15 still a 
giveaway...).

AidWare means that I'll donate all received registration-fees to an organization that supports
developmentprograms in 3rd-world countries.
I hope many of you support this AidWare concept by registering WinCat.

Please read the Important Notice and Registering WinCat for more details !



WinCat/PRO Features
* WinCat/PRO is easy to use
* WinCat/PRO is FAST ! (developed with Turbo Pascal for Windows)
* WinCat/PRO uses state-of-the-art graphics to display data from it's catalog. 

You can choose from a variety of display modes.              
* English, French, German and Dutch language support
* Ability to restore files or extract files from archives. WinCat/PRO interfaces to

all DOS and Windows unarchive utilities (like ARJ, LHA, PKUNZIP, WUNA, 
WINZIP etc.) and other programs using user-defined associations.

* WinCat/PRO can play WAV soundfiles
* Kingsize comment fields on both file- and volume-entries
* Reads subdirectories up to 6 levels deep
* Supports various disktypes (floppydisk, CD-ROM, harddisk, networkdisk etc.)
* Extensive file-search and -view capabilities, fast SPLLASH sorting
* ClipBoard interface for easy editing file-descriptions
* Includes an import/conversion tool that extracts file-descriptions from BBS 

Allfiles-listings, CompuServe CAT listings or listings from other disk catalog 
programs

* Automatically copies file-descriptions from (4DOS) descript.ion files to it's 
catalog

* User-definable reports : Volume Summary, Volume Contents, Files sorted by 
Filename, Duplicate Files and Archive Contents

* Allows you to create easy-to-work-with groups of volumes
* Expensive looking '3D metallic' windows
* Ability to catalog the contents of ARJ, ZIP, LZH, ZOO, PAK and ARC archives
* Ability to export the catalog to a dBase compatible databasefile.
* WOODLE, a graphic disklabel print utility with WYSIWYG layout editor 
* WinCat/PRO can automatically label your floppy-disks



Hints and Tips

 Disk caching
WinCat's archive-scan functions result in quite a bit of I/O on your disks. Use a disk caching 
utility like SmartDrive (preferably the one that comes with DOS 6.2, as this one also supports
CD-caching) or HyperDisk ; this will improve WinCat's (and any other application's) 
performance considerably.

 Catalog backups
When you save a catalog, WinCat first renames the original catalog file to *.BCK, and then 
creates a new *.CAT file that contains all updates.
Please note that, according to Murphy's Law, a backup is something you'll never need unless
you don't have it. So never erase the *.BCK files...
If something happens to the *.CAT file, you can simply rename the *.BCK file to *.CAT and 
continue using that catalog.

 Program limits

Maximum nr. of :
Files on a volume no limit
Files in catalog 20,000 see 'Catalog Size limits' below 
Directories per volume 3,000
Volumes in catalog 1,000

Files displayed on File List window 5,000
Files displayed on Archive List wnd 1,000
Volumes displayed on Volume List 1,000

 Catalog size limits 
WinCat must be able to read an entire catalog into your PC's memory.
This theoretically limits the size of the biggest catalog WinCat can handle to the amount of 
memory your system has available (you can check that on WinCat's Statistics window).
However, WinCat will never be able to use ALL available memory for it's catalog, as some 
memory must remain available for displaying windows, the Window's system routines, 
applications you want to run at the same time as WinCat etc.
My rule of thumb : don't create a catalog that's bigger than half the amount of memory 
that's available.
WinCat needs approximately 900 KB memory for every 10,000 files in a catalog, so, if your 



system has 4 MB memory available under Windows, you can let WinCat use 2 MB of it, and 
create catalogs that contain up to 20,000 files.
You'll notice that, when you're pushing WinCat to the limits, the entire Windows system will 
slow down because Windows has to perform a lot of memory management (i.e. swapping 
memory to and from it's swapfile), and that you might get messages like 'Insufficient 
memory to run application' when starting another program while running WinCat.
 
Another thing to take into consideration : the bigger a catalog, the longer the 
reading,saving, searching and especially sorting will take.
The time necessary to read,save or search a catalog increases linear with the size of the 
catalog.
However, the time that WinCat needs to sort it's catalog increases almost exponentially with
the number of entries to sort.
Sorting is being performed by the 'Import', 'Compare', 'Print files sorted' and 'Print duplicate 
file'    functions.
If you have a rather big catalog, and want to execute one of these functions, consider 
selecting a group of volumes first ; this limits the number of entries to sort, and therefore 
speeds up things.

Please note : 
WinCat has been tested with catalogs that contained up to 20,000 files ; the author cannot 
guarantee WinCat's proper operation when using catalogs that exceed this size. The use of 
catalogs that exceed this size is formally not supported, and at the user's own risk.



WinCat Accessories & Titbits

 WinCat/PRO Extractor 2.1

The WinCat/PRO Extractor is a splendid Public Domain program written by Ole Nebel Nielsen,
Ansager, Denmark.
With the Extractor you can (from the DOS commandline) search single and even multiple 
WinCat/PRO catalogs for files ; the formatted result is written to a file which you can view 
with an editor/viewer of your choice.
The Extractor works with catalogs created by WinCat/PRO 3.2.0 and up.

 CAT2WIN 1.0

CAT2WIN is a tool that converts catalogs created with CatDisk version 7.1 (copyright Rick 
Hillier) to WinCat/PRO format. Not only does it create a WinCat *.CAT catalog, it even creates
the associated *.ACT files that contain information about archive-file contents !
CAT2WIN was created by Ole Nebel Nielsen, Denmark.

The author of WinCat/PRO Extractor and CAT2WIN :
Ole Nebel Nielsen, 
Lindegade 5b
DK-6823    Ansager
Denmark
2:230/137.19@fidonet
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WinCat vs. Papparazzi

"Excellent cataloguer !"
PC-Plus, October '93

"Organise, find and restore files with ease !"
Computer Shopper, August '93 disk

 ShareWare of the Month
The German WIN Magazine, November '93

 "Like a cheetah : fast and elegant !" 
The Dutch PD/SW/FW NewsLetter, Januari '94



System Requirements
In order to run properly, WinCat/PRO requires

 MicroSoft Windows 3.1

 (S)VGA display mode (EGA mode not supported)

 at least 4 MB memory

 at least 2 MB space on your harddisk

 at least 1 diskdrive, harddisk or CD-ROM drive

Recommended :

 Mouse or other pointing device

 WinZip ((c) Nico Mak Computing, Inc.) for extracting archive files

Optional :

 if you want to print disklabels : a printer capable of printing graphics



Turbo Installation of WinCat
The fast way to install WinCat/PRO :

1. create directory C:\WINDOWS\WINCAT
2. create directory C:\WINDOWS\WINCAT\ARCHIVES
3. extract WINCAT34.ARJ into C:\WINDOWS\WINCAT
4. edit WINCATRS.BAT (specify directory of LHA, ARJ and PKUNZIP.EXE)
5. move CTL3D.DLL to the \WINDOWS\SYSTEM directory
6. add WINCAT.EXE and WOODLE.EXE to a Windows program group ; specify C:\WINDOWS\

WINCAT as the working directory !
7. GO!

For more information please refer to Installing WinCat



Installing WinCat
To install WinCat, create directory C:\WINDOWS\WINCAT on your harddisk and extract 
WINCAT34.ARJ into that directory.

You'll have to move 1 file (CTL3D.DLL) to another directory :
File CTL3D.DLL is a link library, required for WinCat's 3D-look. Move this file to the 
WINDOWS\SYSTEM directory. 

If you want to let WinCat catalog the contents of archive files you must also create 
subdirectory C:\WINDOWS\WINCAT\ARCHIVES\ (See also Cataloging Archive Contents).

Edit WINCATRS.BAT and change the 'CD\SHEZ' statement to your directory that contains the 
DOS un-archivers you use, like ARJ.EXE, LHA.EXE and PKUNZIP.EXE .
If these files are accessible through your default PATH, or if you prefer to include the path on 
the 'association' definitions, simply delete this statement.

Now, all that's left to do is to add WINCAT.EXE and WOODLE.EXE to a Windows program 
group.
Make sure you specify C:\WINDOWS\WINCAT as the 'working directory', else WinCat and 
WOODLE can't find the WINCATRS.PIF, WINCATAR.DLL, WOODLE.CFG etc. files.
(see also Automatically Opening a Catalog)

Now start WinCat by clicking it's icon.
Click the 'Catalog' menu on WinCat's primary window, and then select 'Open Catalog...'.
The 'Open' dialog will show 1 catalog file, SAMPLE.CAT.
Select file SAMPLE.CAT and click OK. After WinCat has read this file you can have a first look 
at WinCat/PRO 3.4 !

Once you've tried WinCat you can delete the SAMPLE.CAT, and create your own catalog : 
click the FILE menu, select 'Open Catalog...' and, on the 'Open Catalog' dialog enter the 
name of the catalog you want to create, for instance WINDOWS.CAT.
Note that the filename-extension of catalogs must be '.CAT'.



Uninstalling WinCat
To remove WinCat from your system :

- erase all files in directory WINDOWS\WINCAT
- erase all files in directory WINDOWS\WINCAT\ARCHIVES
- remove directories WINDOWS\WINCAT and WINDOWS\WINCAT\ARCHIVES 
- erase file WINCAT.INI in the WINDOWS directory

WinCat does not alter or add entries to the Windows configuration files WIN.INI or 
SYSTEM.INI



What's new in WinCat/PRO 3.4

General
* When starting WinCat 3.4 for the first time, WinCat will check if there's already a 
WINCAT.INI (made by a prior WinCat release) present in the Windows directory. If so, 
WinCat will rename this file to WINCAT.OLD, and create a new, restructured 
WINCAT.INI file. 

* WinCat/PRO no longer needs the Turbo Pascal runtime library BWCC.DLL, so this file 
has been removed from the WinCat package.

* The WinCat 2.x catalog conversion program CONVERT.EXE has been removed from 
the WinCat package.

* WinCat Help now shows pictures of WinCat's main windows. On these pictures you 
can click any field to get a description of it's meaning or function.

* The Volume List and File List windows now display a short description of a button's 
or menu's function if you select it ; these descriptions can be displayed in either the 
English, French, German or Dutch language.    

* New files in the WinCat package :
WINCATBT.DLL Graphic routines DLL, used by WinCat and WOODLE
WINCATIC.DLL Sample icons for use with the new 'Change Volume Icon' 

function
VENDOR.DOC Information for disk vendors and shareware distributors who 

wish to distibute WinCat/PRO (see also the Vendor Information
section in this help file)

* WARNING : If you make use of the new 'Change Volume Icon' function and save the 
catalog, you cannot load that catalog anymore with a previous release of WinCat !

Options menu
* Main improvement in the 3.4 release is that WinCat now uses superb 3D graphics to
display volumes, files and directories.
You can customize how you want the volume-list, (archive)file-list and directory-list 
windows displayed, using the new Customize Window options on the Options menu.
For each of these windows you can choose between five display modes, ranging from 
out-of-this-world-3D to plain dull. Of course you can also customize the font and color 
used for displaying text, and the window's background color.

* New options on the Configure menu :
- Program to execute when clicking the WUNA button on the Restore File window
- Program to execute when clicking the WinZip button on the Restore File window

* The 'Language' option allows you to select in which language menu's, pop-up-
menu's and help-messages should be displayed ; you can choose from English, 



French, German or Dutch.

Volume menu
* New option : Change Volume Icon ; with this function you can change a volume's 
icon, to be displayed on the Volume List window.
WARNING : If you make use of this function and save the catalog, you cannot load 
that catalog anymore with a previous release of WinCat !

Volume List window
* Clicking the right mouse-button will display a pop-up-menu, where you can select a 
function to perform on the selected volume.

File List window
* The Page-Up and Page-Down menu options have been removed ; WinCat can now 
show up to 5000 entries at once on this list. 

* Clicking the right mouse-button will display a pop-up-menu, where you can select a 
function to perform on the selected file.

* In the continuous endeavor to boldly go where no cat has gone before, the 
technofreaks at the R&D department of WinCat International Inc. have crossed the 
boundaries of modern technology, by developing the amazingly ingenious, highly 
efficient SPLLASH feature (Single-Pass Linklist LookAside with Secondlevel Hashing) 
(TM and HEAVY (C)), which provides sorting capabilities at a speed fast enough to 
catch up with the Starship Enterprise cruising at Warp Factor 11, and while passing it 
make Dr. McCoy speak the historic words 'Damn it Jim, it's a cat, but NOT as we know 
it !'.

 
Directory List window

* WinCat now also retains the position and size of this window. 
 
Catalog Disk window

* Now reads all DESCRIPT.ION files on a disk if you enable the 'Read 4DOS descript.ion
file' option on the Configure window ; prior WinCat releases only looked for a 
descript.ion file in the root directory.

* WinCat now scans subdirectories up to 6 levels deep.

* Now supports PKZIP version 2 archives and multi-volume ZIP and ARJ archives (with 
filename-extension A01-A09) ; WinCat will catalog the contents of these archives if 
you enable the 'Catalog Archive Contents' option on the Configure window.

New in WOODLE 1.1 :
* The format of the WOODLE.CFG configuration file has changed ; therefore WOODLE 
1.1 cannot use a WOODLE.CFG file created with WOODLE 1.0

* Page-layouts are now specified for each individual label-layout.

* In order to enable you to use Avery #5196 labels, WOODLE can now print labels 3 
colums wide on a page.

* Label- and object-borders can now be defined to have rounded corners.

* Labels can now be printed without a border (for instance when using pre-cut labels).
This because some users complained they got depressed by WOODLE's square labels 



with black borderline... 

* You can now also print 4.75" x 1.2" labels for 5.25" disks.

* A label's width and height can now be adjusted, so you can make it fit on pre-cut 
labels    with a non-standard size. 

    



What's new in WinCat/PRO 3.3
General

* A new version of the Turbo Pascal runtime library, BWCC.DLL, is included in the 
WinCat package.
If you already have a file BWCC.DLL in your WINDOWS\SYSTEM directory, please 
check if it's dated prior to 14-01-93 ; if so, replace it by the BWCC.DLL that came with
WinCat.
(note : WinCat will run with any version of BWCC.DLL ; yet it's displays will look better
if you use the newest version).

* WinCat now has a Windows-style Help file (guess you already figured that one 
out...) and context-sensitive Help buttons on all major windows.

* WinCat now makes use of Microsoft's CTL3D.DLL to give it's windows a 3D-look. 
Make sure you move file CTL3D.DLL to the WINDOWS\SYSTEM directory.
Note : there are older versions of file CTL3D.DLL around ; when using one of these, 
WinCat will not be able to show windows in color.

      
Volume List window

* Volumes can now be sorted in ascending or descending free space order.

Volume Information window
* You can now use the Set default and Get default buttons to more easily define a 
volume's Group, Location and Owner fields.

File List window
* A limitation in MicroSoft Windows is that a listbox can only contain a maximum of 
64K data ; this limited the number of files that could be displayed on the File List 
window to 847.
To overcome this limitation, the File List window now uses a paging technique, with 
which you can display up to 6 pages of 847 files each.
* Sorting by date or size can now be done in ascending or descending order.

Restore File window
* Now displays a 'Play' button for WAV soundfiles. If you click OK, WinCat will play the 
selected WAV file.    

File Information window
* Now also shows the group-id and location-id assigned to the disk that contains the 
file.

Directory window
* The routine used to display the files in a directory on a volume with several 
thousands of files has been made significantly faster.

Search Files window
* In addition to entering a filename-extension to search for, you can now also select a



specific function class (a set of extensions) to search for.

Select Drive window
* Now displays up to fourteen buttons that represent the drives on your system 
(including CD, harddisk- and network-drives).
* The 'Catalog archive contents' and 'Display Recatalog window' options have been 
moved to the Catalog Disk window.

Catalog Disk window
* When you enter or alter a floppydisk's Volume-ID on the this window, you can let 
WinCat write this new ID as a volume-label on the disk.
* After a disk has been cataloged, WinCat now optionally displays the Volume 
Information window, where you can enter the disk's description and group fields.

Printing Disklabels
* You can now print (adhesive) disklabels for the disks you've cataloged, using the 
new WOODLE (WinCat Object-Oriented Disk Label Editor) feature.
With WOODLE's What-You-See-Is-What-You-Get Graphic Label Editor you can easily 
define the layout of those labels : apart from including catalog-information like the 
disk's volume-id and description, you can add your own text, select any font you 
fancy, and even include your own bitmap pictures !
By simply moving and sizing all objects that make up the label you can make it fit 
your taste.

Printing Reports
* When printing a listing (either by using the 'Report ...' option on WinCat's main 
menu, or by clicking the 'Print' button on a listbox), WinCat now displays a window 
where you can :
- cancel the print
- select the print destination (either to a file, or directly to your printer)
- indicate you want to edit the listing (if you select 'File' as destination) after it has 
been created.
* New report : Archive Contents. This report lists all archive-files on the selected 
volumes, together with the files that reside in those archives.
* A new Options window allows you to select the fields you want included on the 
reports to print.

Import window
* You can now also import file-descriptions from CompuServe (TAPCIS) *.CAT listings ; 
WinCat will copy the file-descriptions from the Title lines to it's catalog.

Configure window
* New options :
Auto-save catalog (if this option is set an updated catalog will be automatically saved
when you end WinCat, or when you open another catalog)
Display Volume Information window (if set, this window will appear after a new disk 
has been cataloged)
Write volume-label on disk if changed (if set, WinCat will update a disk's volume-label
if you    altered the volume-ID on the Catalog Disk window)
Display toolbar (if set, toolbar-buttons will be displayed on the Volume- and File-List 
windows)



What's new in WinCat/PRO 3.2
WinCat/PRO 3.2.0 is primarily a 'bugfix' release (there proved to be an error in 25 of the 
11,728 lines Pascal poetry that make up WinCat/PRO).
However, a number of new features also have been added :

General
* In order to reduce the size of catalogs the catalog structure has been changed.
Note that WinCat 3.2.0 can read 3.0 catalogs, but WinCat 3.0 CANNOT read catalogs 
saved by WinCat 3.2.0 !
          
* You can now let WinCat open a specific catalog immediately upon startup.
Specify the name of the catalog to open on the Program Managers' 'Program Item 
Properties' window, e.g. like this :
Commandline : C:\WINDOWS\WINCAT\WINCAT.EXE    WINDOWS.CAT    or 
C:\WINDOWS\WINCAT\WINCAT.EXE    D:\DATA\WINDOWS.CAT

So, if you have multiple catalogs, you can define a few WinCats to the Program 
Manager, and let each of them use a different catalog.

* WinCat now displays the 5 last catalogs you used on the 'File' menu, so you can 
simply select the catalog you want to open.

Volume List window
* When double-clicking a volume, WinCat now also updates the 'Directory List' 
window if it's visible.

* A new 'Sort' menu allows you to sort the volumes displayed on the Volume List 
window in Volume-ID, free space or group order.

* You can now customize which program to run when clicking the Programmanager, 
Filemanager or Taskmanager button by specifying them in WINCAT.INI. 

File List window
* Menu added

* Files can now be sorted in filename, extension, directory, volume, date or size order.

* With the 'View' option you can limit the files displayed to those belonging to a 
certain 'function class', e.g. programs, documents, sourcefiles etc.
Each class represents one or more filename-extensions. For instance, to class 
'Programs' belong all files that have extension EXE,COM,BAT or PIF.
You can customize the predefined classes by overriding them in WINCAT.INI ; see File 
List window [ VIEW ].

Archive File List window 
* Menu added
    



* Files can now be sorted in filename, extension, archive, volume, date or size order.

* The same 'View' option as on the File List window.

Restore File window
* Now enables WINZIP button for ARJ,ZIP,LZH and ARC archive files
You can override the default WUNA and WINZIP commands in file WINCAT.INI, e.g. like
this :
Wuna=c:\windows\tools\wuna.exe < -p>
Winzip=c:\windows\tools\winzip.exe <

Directory window
* Now modeless ; you don't have to close it to perform other functions on the Volume 
List window.

* You can now make a selection out of all directories on a volume by specifying a 
'look-for' character-string.

Select Drive window
* Now displays a button for every drive on the system (including harddisk- and 
network-drives), so the contents of harddisks also can be cataloged.

* Now also accepts empty disks to be cataloged.

* The level of subdirectories that WinCat checks has been increased from 3 to 4.

Catalog Disk window
* Now also scans contents of .ZOO archive files.

Select Group window
* You can now select all volumes of a certain disk-type, e.g. all 3.5" 1.44 MB disks.

Configure window
* New option : Default catalog directory.



What's new in WinCat/PRO 3.0
First release of the Turbo Pascal version.
A summary of changes in WinCat/PRO, compared to (the Visual Basic version) WinCat 2.5.

General
- WinCat now supports multiple catalogs.
Related options on the 'File' menu : Open Catalog, Save Catalog, Save Catalog As and
Save Group As

Volume List and File List windows
- The Volume List and File List windows are now 'modeless' windows ; this means that
you can use functions on the Volume List window without closing the File List window 
first. 

Volume Information window
-You can now define two more 'group' fields : location and owner.

- The pie-chart showing free and used space has been replaced by a linear 
'stuffometer' that also shows the used space in percent. 

- Entering a series of descriptions that are (almost) the same (e.g. Windows disk 1 of 
6, disk 2 of 6 etc.) has been made easier ; you can let WinCat memorize descriptions 
by entering a description in the edit field and clicking on the 'Mem' key. 
You can then simply select descriptions from the drop-down list.

Restore File window
- Now has 2 more options : 'Run' and 'Edit'.
This window also shows a (disabled) 'Delete' button, but at the moment this function 
is not supported. Wait for 3.1... 

- WinCat now uses it's own routines to copy a file from floppy to harddisk (instead of 
calling DOS copy).

Select Group window
- You can now also select those volumes that have a minimum amount of free space, 
or volumes that belong to a specified owner or location.
        
- When you select a group,    ALL WinCat functions (like search, print, import, export 
etc.) will operate only on (files on) volumes belonging to that group.
Only exception : the 'Save Catalog (As)' function ignores groups. 

Catalog Disk window
- You can now enter a volume's description on this window.
Entering a series of (almost) identical descriptions has been made easier by 
implementing the same 'Memorize' function as on the Volume Information window.

- The way WinCat scans archivefiles has been improved :



      
* by changing the order in which archive-files are processed (directory-order instead 
of filename-order) scanning an entire CD-ROM now takes less then half the time it 
took with WinCat 2.5.

* when recataloging a disk, WinCat will now first examine the old .ACT file that was 
associated with that disk. By doing so, WinCat doesn't have to scan archive-files that 
were examined previously and haven't been changed since : he simply copies their 
contents-information to the new .ACT file, and only scans those archive-files that are 
new or updated.

- WinCat can now catalog CD-ROMS that contain any number of files.

Utilities Menu 
- 'Export' is a new function you can use to copy WinCat's catalog data to a file in .DBF
format (for use with dBase, FoxPro etc.)



Bugs Fixed
Summary of bugs that where reported in WinCat/PRO 3.3.0, and that have been eliminated 
in WinCat/PRO 3.4.0 if possible : 

PRB0041
Symptom 'Retry/Cancel' message when opening Drive Select window.
Occurs When no CD or an audio CD present in CD-drive.
Modules WCSELDRV.PAS
Status fixed 06-12-93

PRB0042
Symptom WinCat's displays look chaotic ; list headers cover items on listbox, 'used 

space'-bar on Volume Information window at wrong position, etc.
Occurs When using 800x600 or 1024x768 display mode with large font.
Modules All -sigh-
Status fixed 05-12-93

PRB0043
Symptom Volume Information window shows wrong 'used space' value for CD's 

(always 134.2 MB) 
Modules WCGLOBAL.PAS(ScanVolume)
Status fixed 23-11-93
Note You'll have to recatalog your CD's in order to update the 'used space' 

value displayed on the Volume List window. 

PRB0044
Symptom Volume Information window shows wrong disktype for Bernoulli disks 
Modules
Status open

PRB0045
Symptom Catalog Statistics window shows negative used and/or free space values. 
Modules WCGLOBAL.PAS(FFormat)
Status fixed 23-11-93

PRB0046
Symptom Pressing 'Select Group' button after an empty group was selected results 

in message 'First select volume on Volume List window'
Modules WINCAT.PAS(TWinCatDialog.SelectGroup)
Status fixed 25-11-93

PRB0047
Symptom After letting WinCat write a volume-label on a disk, it's impossible to 

catalog another disk ; message 'retry/cancel' appears when clicking drive 
button on Drive Select window, or info from previous disk shows up again.

Occurs When using SHARE.EXE, or when using Windows for WorkGroup's virtual 
SHARE.



Cause WinCat didn't close the file created as volume label. Stupid cat...
Modules WCGLOBAL.PAS(WriteVolumeLabel)
Status fixed 9-1-94

PRB0048
Symptom Static text fields show gray instead of user-defined window background 

color.
Modules WCGLOBAL.PAS(WMCtlColor)
Status fixed 25-11-93

PRB0049
Symptom At times, nothing happens when clicking the 'Open Catalog' option on the 

'Catalog' menu.
Modules WINCAT.PAS(OpenCatalog,SaveCatalog,SaveCatalogAs)
Status fixed 25-11-93

PRB0050
Symptom HotLine (a shareware program which monitors Windows API-calls) reports 

invalid function calls when running WinCat and WOODLE.
Status fixed 27-12-93

These bugs were fixed in WinCat/PRO 3.3 :

PRB0031 Static textfields show up with white instead of gray background. 
PRB0032 Paradox for Windows issues message 'Unable to open table ; error in table

header' when opening a .DBF file created with WinCat.
PRB0033 WinCat only shows the first five of all available drives on the Drive Select 

window.
PRB0034 Unable to customize program to be executed when clicking the 

'Filemanager' button on the main window. 
PRB0035 When cataloging a disk, the status displays on the Drive Select window 

and on the Catalog Disk window get truncated if the text doesn't fit on 
one line.    

PRB0036 The 'Settings' window doesn't show fore- and back-ground colors selected 
by user.

PRB0037 Runtime error at 0008:011E when recataloging an empty disk.
PRB0038 Runtime error when cataloging archive file with more than 512 files.
PRB0039 WinCat doesn't always scan updated archive-files when recataloging a 

disk.
PRB0040 'Lines read' counter on import window starts counting backwards when 

importing huge textfile

These bugs were fixed in WinCat/PRO 3.2 :

PRB0001 Runtime error 2 when ending WinCat, or message 'catalog does not exist'
when opening an existing catalog, etc.

PRB0002 Runtime error 5 when saving a catalog. 
PRB0003 The used/free space graphic display on the Volume Information window 

doesn't show info for first selected volume. 
PRB0005 WinCat doesn't recognise 'Floptical' disks. 
PRB0006 If there is more than 9999K free space on a volume, the 'free space' 

value on the Volume List window gets truncated.
PRB0007 WinCat can't scan the contents of archive-files that have the 'read-only' 



attribute.
PRB0008 WinCat shows wrong filenames in archive if archive contains directory 

names.
PRB0010 Beep and empty 'Archive Contents' window when displaying contents of 

archive file.
PRB0011 When cataloging a volume with the 'catalog archive contents' option set, 

WinCat creates a .ACT file even if the volume doesn't contain any archive 
files.

PRB0012 WinCat ignores user-selected font on startup, and instead uses default 
TERMINAL font.      

PRB0013 Message 'Filename-extension must be .CAT !' when creating a new 
catalog with an 8-character filename (e.g. PICTURES.CAT).

PRB0015 Runtime error at 0003:2652 when saving a catalog
PRB0016 Message 'WINCAT.EXE caused General Protection Failure', followed by 

message 'runtime error at <some address>', or message 'Function 
returncode = xx'.    

PRB0017 Unable to resize the Volume List window ; it stays full-screen.
PRB0018 Instead of picture-buttons, 'empty' buttons with the text 'No Bitmap !' 

show up. Some BMP's don't show at all.
PRB0019 At times, WinCat's icon turns into a black hole, or shows another 

program's icon.
PRB0020 Text at bottom of Volume List window gets truncated 
PRB0021 When clicking 'exit' button on File List window, this window gets 'iconized'

instead of invisible.    
PRB0023 When cataloging a disk, WinCat reads descript.ion file regardless of the 

setting of the 'read descript.ion' option on the 'Configure' window.
PRB0024 Runtime error & message 'Segment Bounds Exceeded' when loading a 

catalog. 
PRB0025 Message 'Unable to read the disk's directory' when cataloging an empty 

disk.
PRB0027 Volume description entered on Volume Information window gets 

truncated.
PRB0028 When ending WinCat using the 'Close' option from the system menu, 

WinCat ends immediately without asking the user if updates should be 
saved first. 

PRB0029 Target directory selected on Restore window ignored by WUNA.

Things to Come
The new WinCat/PRO release 3.5 :

 will it be able to catalog tape-streamer tapes ?

 does it allow storing bigger volume- and file-comments ?

 will Microsoft buy WinCat ?

 or will WinCat International Inc. swallow up Microsoft ?



 or perhaps join forces with Apple and IBM to create PowerCat ?

 and what about WinCat going 'Open Systems' ?

 will there be even more features and functions in WinCat ?

 or will the author finally find something usefull to do ?

Satisfy your curiosity...
Give your puzzled mind a rest...

Find the answers to these burning questions, 
that haunt your mind like ghosts haunt Chaos Manor...

Tune in on the next release of the amazing,
the one and only 

Planned General Availability : euuuh... we'll see.



Search Files window
Allows you to search for files in the catalog (by clicking the FILES button), or for files in 
archives (by clicking the ARCHIVES button).



Enter string(s) to search for
To search for files in the catalog (or files in archives) you must enter the character-string(s) 
you want WinCat to look for on the Filename, Extension, Directory and/or Comment fields.
WinCat will compare the strings you enter with the corresponding fields of all file-entries in 
the catalog, and show the files that match. Examples :

To find all files with characterstring ICO in their filename :
Filename : ico

To find all files with characterstring ICO in their filename AND string edit in their comment-
field :
Filename : ico
Comment : edit (note : this field cannot be used to search for files in archives) 

To find all BMP files :
Extension : bmp

To find all executable files in the Windows directory :
Extension : Programs (selected from drop-down list)
Directory : windows (note : this field cannot be used to search for files in archives)

Note that WinCat does NOT support DOS-like wildcards ; entering something like *.CAT on 
the Filename field will result in '0 files found'.



Search for Function Class
By selecting one of the entries displayed on this list, you can search for files that belong to 
the selected Function Class. For instance, if you select class 'Programs' WinCat will search for
files with filename-extensions EXE, COM, BAT or PIF.
Tip
You can customize the predefined classes ; see View 



Search Files
Click this button to search the catalog for files that match the selection criteria.
Before clicking this button, enter at least one argument on the Filename, Extension, 
Directory, Comment or Size field, or select Search by Date.    



Search Files in Archives
Click this button to search for files withing archive-files (like ARJ and ZIP).
Before clicking this button, enter at least one argument on the Filename, Extension or Size 
field, or select Search by Date.
Note : you cannot search files in archives by Comment or Directory.    



Clear Fields
Click this button to clear all search fields.



Cancel
Click this button to close the 'Search' window.



Status Information
This line shows the number of volumes in the currently selected group (see also Select 
Volume Group), and the total number of files on those volumes.



Search by date
If you want to look for files by date, you must check this option.
To set the required date, use the Year, Month and Day scrollbars at the right of this window. 
As you do this, you'll see the date-value change.
Next select whether you want to look for files older than, from, or newer than this date by 
clicking the appropriate checkbox on the right of this window.



Search by size
Use this field to search for files that exceed a given size.
If you enter 100, WinCat will display all files that are bigger than 100 KBytes. 



Set date
With these options, you can select whether you want to look for files older than, from, or 
newer than the date displayed.



Set date
Using the Year, Month and Day scrollbars you can set the 'search-for' date. As you do this, 
you'll see the date-value change.



Rename Volume window
On this window you can change the ID of a volume in the catalog.
The new ID you enter must be unique ; if there is already a volume cataloged with the new 
ID, a messagebox appears prompting you to enter a different ID.

Note that WinCat only changes the volume-id in the catalog ; it does NOT change the 
disklabel on the disk.



Catalog Disk window
When you select a drive on the Select Drive window, WinCat scans the directory of that disk 
and displays the Catalog Disk window, which shows the contents of the disk.

On this window you must enter a volume-ID for the disk to be cataloged.    This ID may be 1 
to 11 characters long, and must comply with the DOS naming conventions ; therefore, you 
can not use these characters : * ? / | . ; : = [ ] ( ) & ^ < > "
 
If the disk was labeled, the ID-field will show the label. You're free to change it : WinCat 
doesn't require that disklabel and (external) volume-ID are equal.
However, the easiest way to work with WinCat is to give every disk a unique label, and then 
let WinCat use these labels as volume-ID's.
Therefore the Catalog Disk window also has a 'write changed volume-id to disk' option : if 
you select this option, WinCat will automatically (re)write a floppydisk's label if you alter the 
volume-id.

When you click OK, WinCat will scan the catalog to see if the volume-ID you entered is 
already in use. If it isn't, the volume- and file-information will be added to the catalog.

If there IS a volume with the same ID in the catalog, WinCat's action depends on the setting 
of the 'Display Recatalog Window' option. 
If this option is turned on, WinCat will display the Recatalog Disk window where you must 
either confirm or cancel the recatalog operation ; else WinCat will automatically recatalog 
the disk.

Recataloging means that WinCat will delete the old volume (and it's files) from the catalog 
and add the new volume- and file-information to the catalog.    Volume- and file-comments 
will be copied
from the old to the new volume- and file-records.

After WinCat has added or replaced the volume in the catalog, he will optionally continue 
with :
1. scanning the DESCRIPT.ION files on the disk
2. scanning the archive-files on the disk
3. displaying the Volume Information window, where you can enter a description for the disk.

Whether or not WinCat performs these actions depends on the the setting of the appropriate
options on the 'Catalog Disk' and 'Configure' Configure windows.



Erase Disk
Clicking the 'Erase Disk' button on the Volume List window will delete the selected volume 
(and all files cataloged on it) from the catalog.
If there is a corresponding archive contents (.ACT) file this will be deleted as well.
Of course you'll receive the inevitable prompt 'are you sure ?'.



Recatalog Disk window
After clicking OK on the Catalog Disk window, WinCat will check whether the Volume-ID you 
entered is already in use.
If there IS a volume with the same ID in the catalog, WinCat will display the 'Recatalog Disk' 
window.

This window compares the information that's already in the catalog with the actual contents 
of the disk to be cataloged and displays the differences between them :
- files that are on the disk, but not yet cataloged
- files that are cataloged, but can't be found on the disk
- files on the disk that are newer than the ones cataloged
- files on the disk that are older than the ones cataloged

If you click the OK button, WinCat will return to the 'Catalog Disk' window and recatalog the 
disk.
This means that WinCat will delete the old volume (and it's files) from the catalog and add 
the new volume- and file-information to the catalog.    Volume- and file-comments will be 
copied
from the old to the new volume- and file-records.

If you click the Cancel button, WinCat will return to the 'Catalog Disk' window, where you can
either enter a different volume-id, or cancel the catalog function.

Remember that this window doesn't appear if you have turned the 'Display Recatalog 
window'
option (on the Catalog Disk window) off. In this case WinCat automatically recatalogs the 
volume.



Drive Select window
When you click the 'Add Disk' button on the Volume List window to catalog a disk, WinCat 
first displays the Drive Select window, which shows a button and an icon for each 
floppydisk-, harddisk- or CD-ROM-drive installed on your PC, and (if your workstation is 
connected to a LAN) the network-drives that are accessible.

Insert a disk in a drive (if applicable) and then select this drive by clicking the appropriate 
drive-button.

After scanning the directory of the disk WinCat will continue by displaying the Catalog Disk 
window, which shows the contents of the disk.



Define Association window
On this window you can define the associations to be used by the Restore File function.

Associations are used by the Restore File function to determine which command to generate,
depending on the selected file's filename-extension.
Main purpose in WinCat is to associate archive files (like ARJ) with their unarchive utilities, 
but if you like you can use them for lots of other purposes.
Unlike the Windows File Manager, where you can associate only one application with an 
extension, WinCat lets you define up to three different associations, which can be used to :
    - extract files from an archive
    - view the contents of an archive
    - some other function defined by you

To define an association, you must enter one or more commands, like

DOS ARJ E < > (extract .ARJ files)
DOS C:\TOOLS\PKUNZIP.EXE < > (extract .ZIP files)
DOS PKUNZIP -v < (view contents of .ZIP files)
NOTEPAD < (edit .DOC files)
C:\WINDOWS\WRITE.EXE < (edit .WRI files)
COPY < > (copy a file from floppy to harddisk)

The Restore function will replace the '<' with the name of the selected file, and '>' with the 
selected target directory.

If a command begins with 'DOS ' it will be executed as DOS command in a DOS window, else
it will be executed as a true Windows application.

Click OK to save the defined command(s) in file WINCAT.INI and end the 'Associate' window.
Click Cancel to exit this window.



Volume Information window
The Volume Information window displays relevant data about the selected disk.
Click any field or button to get a description of it's function :



Scrollbar
Use the scrollbar to quickly scroll to another volume. If you do this, any updates you made 
on the Description or Group fields will be saved automatically.



Disk Type
Shows what kind of disk this is (e.g. 3.5" 1.44 MB, CD-Rom, harddisk etc.)



Number of files
This is the total number of files on this disk.



Date
The date this disk was cataloged.



Archive Contents file
The filename of the archive contents file associated with this disk (applicable only if the 
contents of archive files on this disk were cataloged).



Used and free diskspace
Shows the amount of used and free diskspace on this disk, in nnnK (K=1,000) or nnn.nM 
(M=1,000,000) bytes.
The 'stuffometer' shows the 
- amount of used space in blue
- amount of free space in green
- used space in percent of the disk's storage-capacity



Volume Description
On this field you can enter a description of the disk's contents.
Tip
To make it easier to enter a description for a series of related volumes (i.e. Windows 
Installation Disk 1 of 7, 2 of 7 etc.), you can use the Memorize button. Clicking this button 
will add the current volume description to the drop-down list ; after scrolling to another 
volume you can select that description again from the list.



Get/Set default group
To make it easier to enter the same Group, Location and Owner fields for a series of related 
volumes, you can use these buttons :    
Set Default Group : save the current Group, Location and Owner fields.
Get Default Group : retrieves the previously saved Group, Location and Owner fields 



Group, Location and Owner fields
Here you can define to which group, location and/or owner a disk belongs.
Each of these fields may be 1 to 8 characters long. You can enter new identifiers in the edit-
boxes, or select existing identifiers from the drop-down lists.



OK button
Clicking this button will save the Description and Group fields in the catalog, and end the 
Volume Information window. The Volume List window will show the updated Group and 
Description fields.
Tip
Another way to save these fields is to scroll to another volume, using the scrollbar at the left.
If you do this, all updates will be saved automatically, i.e. you don't have to click OK.



Cancel button
Clicking this button will end the Volume Information window. Any changes you made on the 
current disk's Description or Group fields will be discarded.



File Information window
The File Information window shows relevant data about the selected file.

You can use this window to update the file's description.
If you click OK, WinCat will save the updated description in it's catalog.
The scrollbar at the left can be used to quickly scroll to other files. If you do this updates will 
be automatically saved, so then there's no need to click OK.

Click the [archive info] button to display the contents of an archive file on the Archive 
Contents window.



Archive Contents window
This window shows the files in a particular archive file.

At the top of this window you can see :
- the size of the archive file itself
- the total uncompressed size of all files in the archive
- the number of files in the archive
- the last date any of the files in the archive was modified

You can print the contents of the selected archive file by clicking the Print button.



Restore File window
This function can be used to restore files from floppy- to harddisk.
The 'Restore File' window shows at the top the command that WinCat will execute if you click
OK (you may edit this line).

The command that WinCat generates depends on the combination of (filename-)extension 
(i.e. the associations you defined for that particular extension), the selected option in the 
'action'-box, the selected target directory and the selected source drive.

The 'action'-box has 8 buttons :

Copy file to harddisk Active for all files
Edit file Active for all files
Play file Active for WAV files 
Run Active for EXE, BAT, PIF and COM files 
Call WUNA Only active for ARJ and ZIP files
Call WinZip Only active for ARJ, ZIP, LZH and ARC files

The following buttons are visible only if there is an association defined ( see 'Associate' ) :

Extract files from archive
View contents of archive
User defined function

If the generated command begins with 'DOS ' WinCat opens a DOS window to execute the 
(DOS) command through WINCATRS.BAT, else it will be launched as a Windows application.

(see also WUNA and WinZip)



Close File-window
Clicking this button will close the File List window.



Tag File
Click this button to put a 'tag' (displayed as a green LED) on a particular file.
This can be useful when you're searching for a couple of files ; first use the 'Search' function 
to find the files one by one and tag them. After you've found what you were looking for click 
'Display tagged files' on the 'File' menu et voila, there they are.



Alternate Display
Clicking this button will alternately display the files with their comment field only, or with 
volume, creationdate and directory fields.



Copy, Edit and Paste File Comments
COPY TO CLIPBOARD
Selecting this menu-option will copy the filenames and their descriptions from the File List 
window to the ClipBoard.

EDIT
Selecting this menu-option will run NotePad (or the editor you specified on the 'Editor=' 
statement on the 'Configure' window), where you can paste in and edit the file-descriptions 
you put on the ClipBoard with COPY.
When you have completed editing, use the editor to copy the data back to the ClipBoard and
then use PASTE to retrieve the descriptions from the ClipBoard.

PASTE FROM CLIPBOARD
Retrieves file-descriptions from the ClipBoard and stores them in the catalog.
The ClipBoard records must have the format 'Filename.Ext Text'.
The filename may be in upper- or lowercase.



Print File List
Selecting the Print menu-option on the File List window will print the contents of the File List 
window on your printer, or to file WINCAT.LST.



View 
With the 'View' menu-option on the File List window you can limit the files displayed to those
belonging to a certain 'function class', e.g. programs, documents, sourcefiles etc.

Each class represents one or more filename-extensions. For instance, to class 'Programs' 
belong all files that have extension EXE,COM,BAT or PIF.

WinCat can use up to 9 classes ; 8 of them have been predefined :

1: Archives ARJ,ZIP,LZH,PAK,ARC,ZOO
2: Programs EXE,PIF,BAT,COM
3: Documents DOC,TXT,WRI,INI,RTF
4: Sources PAS,RES,RC,H,C,ASM,BAS,DLG,FRM
5: Graphics BMP,GIF,PCX,TGA,RLE,ICO,FLI
6: Soundfiles WAV,ROL,VOC,MDI,MOD,SND
7: Drivers/DLL DLL,DRV,SYS
8: Fonts FON,FOT,TTF,ATM,PFB,PFM

You can customize these classes by defining them in WINCAT.INI, section [Classes].
A few examples :

- You want to add extension 'TEX' to class 3, Documents :
[Classes]
:
Class_3=Documents,DOC,TXT,WRI,INI,RTF,TEX

- You want to define class 9 as 'Excel', using extensions XLC,XLS,XLM XLA and CHT :
[Classes]
:
Class_9=Excel,XLC,XLS,XLM,XLA,CHT

Note : the extensions you define MUST be separated with ','. Don't enter any other 
characters in between. For each class you can define up to 10 extensions.



Scanning 4DOS DESCRIPT.ION file
One of the nice features of 4DOS is that you can assign descriptions to your files. 4DOS 
saves these descriptions in -hidden- file(s) called 'DESCRIPT.ION'.
These are 'plain' ASCII text files, i.e. their contents might look like this :

afile.exe just one of my files
wincat34.arj SPLENDID program : I'm gonna mail the orderform today !
descript.ion This comment describes the volume contents
somefile.arj This is another file

When cataloging a disk, WinCat scans all directories of this disk for 'DESCRIPT.ION' files and, 
if found, copies the file-descriptions from these files to it's catalog.
If there is an entry 'descript.ion' in the descript.ion file, WinCat will use it's description as a 
volume-description (get my point ?).
If you don't want WinCat to read the DESCRIPT.ION files, disable the appropriate option on 
the Configure window.



Cataloging archive contents
You can optionally let WinCat catalog the contents of ARJ,ZIP,LZH,PAK, ZOO and ARC archive 
files.

When WinCat scans the archive files on a disk, he saves the contents-information in a 
special directory in a file named Fxxxxxxx.ACT, where xxxxxxx is some generated 
(timestamp) string.
So, for every volume that WinCat scanned there is a .ACT file in this directory.
On the 'Volume Information' window you can see which .ACT file (if any) belongs to a 
volume.

Note that there is a one-to-one relationship between a volume and it's associated .ACT file ; 
therefore you shouldn't rename or delete .ACT files yourself, because then WinCat looses 
track and instead of the contents of an archive file will show you the message 'Can't find file 
Fxxxxxxx.ACT'.

If you request WinCat to show the contents of a particular archive file, WinCat locates 
the .ACT file that's associated with the volume that contains the archive file and extracts the
requested information from it.

So, to activate the cataloging of archive contents you must do 2 things :

1. Create the subdirectory where WinCat can store it's .ACT files.
As a default, WinCat uses directory C:\WINDOWS\WINCAT\ARCHIVES.
If you want to use another directory you must specify it's full name on the Configure window 
(option 'Archive Directory'), e.g. 'D:\USERDATA\' or 'C:\WINDOWS\WINCAT\'

2. Turn on the 'Catalog Archive Contents' option on either the Configure window 
or the Catalog Disk window.

If an error (CRC check, I/O error or whatever) occurs while scanning an archive file then 
WinCat aborts processing the current archive and proceeds with the next one.



Cataloging CD-ROM disks
If you have a CD-ROM drive and the appropriate device-drivers installed on your system you 
can let WinCat also catalog the contents of your CD-ROM disks.
This isn't any different from cataloging floppy-disks ; WinCat will enable a drive-button on 
the Drive    Select window, and all you have to do is to click this button.

Note that, because of the large number of files contained on CD-ROMs, it can take quite 
some time to let WinCat catalog a CD, especially if you want WinCat to catalog the contents 
of archive files too.
You can speedup things considerably if you use Microsoft's new SmartDrive 4.0 disk caching 
utility (SMARTDRV.EXE) that comes with DOS 6.2.
This new version is able to cache CD-ROM's, with quite impressing results : without 
SmartDrive, it took about 70 minutes to catalog the CICA 93-11 CD. With SmartDrive, it took 
just 15 minutes.
    



File Manager and Task Manager
Clicking the File Manager or Task Manager button on the Volume List window will cause 
WinCat to run or switch to the corresponding Windows application.

As a default, WinCat runs these programs :
Task Manager : TASKMAN.EXE
File Manager : WINFILE.EXE

If you want WinCat to execute a different program, specify it's name in WINCAT.INI like this :

[Directories]
FileMan=C:\WINDOWS\PROGRAMS\MYFILE.EXE
TaskMan=C:\WINDOWS\PROGRAMS\MYTASK.EXE

Note : some non-Microsoft managers (like PC-Tools' File- and Task-managers) do not support 
this 'switch to' trick ; instead of switching to the already active manager, they'll simply 
display a message like 'Filemanager already running', or simply start a second application.
Well, appearently not all software is as flexible and well-thought-of as ye ol' WinCat or my 
friend Bill's goodies... "-)



Catalog Backups
When you save a catalog, WinCat first renames the original catalog file to *.BCK, and then 
creates a new *.CAT file that contains all updates.
Please note that, according to Murphy's Law, a backup is something you'll never need unless
you don't have it. So never erase the *.BCK files...
If something happens to the *.CAT file, you can simply rename the *.BCK file to *.CAT and 
continue using that catalog.



WinZip and WUNA
You can let WinCat's Restore File function call WUNA (a shareware Windows UnArchive tool 
by James N. Hughes that can extract ZIP and ARJ files) or WINZIP (a shareware Windows 
unarchive tool by Nico Mak Computing, Inc. that can create and extract ARJ,ZIP,LZH and ARC
files).

As a default, WinCat doesn't specify a path when calling WUNA.EXE or WINZIP.EXE, so if you 
want to use WUNA and/or WINZIP make sure these files are in your \WINDOWS directory, or 
specify their location on the Configure window.
(Of course you can also specify the name of another program you want to run when clicking 
the WinZip or WUNA button).

You can download WUNA and WINZIP from any WINNET BBS.



Contents of WinCat ARJ/ZIP archive
WINCAT.EXE The WinCat program
WINCAT.HLP WinCat Help file
WINCATBT.DLL Graphic routines DLL , needed by WinCat and WOODLE
WINCATAR.DLL WinCat's Archive Scan routines
WINCATIC.DLL Icon Library, contains icons for use on the Volume List 

window
WINCATRS.PIF PIF that WinCat uses to launch WINCATRS.BAT.
WINCATRS.BAT BAT that WinCat uses to execute DOS unarchive utilities (like

ARJ.EXE)
WOODLE.EXE WOODLE - WinCat Object Oriented Disk Label Editor
WOODLE.CFG WOODLE's layout definitions file, used to save the layouts 

you define
SAMPLE.CAT A sample catalog
ORDERFRM.DOC How to order your WinCat/PRO license
ORDERFRM.WRI The orderform in Windows Write format 
README.DOC For turbo-installers who never read help files
VENDOR.DOC Information for disk vendors and shareware distributors, who

wish to distribute WinCat.PRO (see also the Vendor 
Information section in this help file).

FILEID.DIZ Short description of WinCat's features
CTL3D.DLL(1) Link library required for WinCat's 3D look

(1) Copyright Microsoft



Virus Protection
Both the WINCAT.EXE and WOODLE.EXE programs perform a selftest each time you run them
; they will warn you if the program has been infected by a virus (be it of electronic or human 
nature) or otherwise damaged by displaying a message and ceasing execution. If this 
happens, reinstall the original, unmodified WinCat/PRO and WOODLE programs from the 
WINCAT34.ZIP or WINCAT34.ARJ distribution-package.



WINCAT.INI
The WINCAT.INI file (in the \WINDOWS directory) looks like this :

[Directories]
* Commands used to launch unarchive tools, used by Restore File
Wuna=WUNA < -p>
WinZip=WINZIP <
* Programs to run when clicking the File- or Task-manager button    
FileMan=WINFILE.EXE
TaskMan=TASKMAN.EXE
* Editor to be used by WinCat 
Editor=c:\windows\notepad.exe
* Directories
Archive_Directory=c:\windows\wincat\archives\
Restore_Directory=c:\
Catalog_Directory=c:\windows\wincat

[Options]
Date_Format=DDMMYY
Use_4DOS=YES
Rep_4DOS=NO
Confirm_Recatalog=YES
Scan_Archives=YES
Update_Label=NO
Auto_Save=NO
Disp_VolInfo=YES
Hide_Toolbar=NO

[VL_Display]
* position, color and font information for the Volume List window

[FL_Display]
* position, color and font information for the File List window

[AL_Display]
* position, color and font information for the Archivefile List window

[DL_Display]
* position, color and font information for the Directory List window

[Catalogs]
* These catalogs appear on the 'Catalog' menu 
Catalog_1=
Catalog_2=
Catalog_3=
Catalog_4=
Catalog_5=

[Associations}
* Associations used by Restore File



EXTR_ARJ=DOS arj e < >
VIEW_ARJ=DOS arj v <
USER_ARJ=
EXTR_ZIP=DOS pkunzip < >
VIEW_ZIP=DOS pkunzip -v <
USER_ZIP=
EXTR_LZH=DOS lha e < >
VIEW_LZH=DOS lha v <
USER_LZH=
EXTR_LHA=DOS lha e < >
VIEW_LHA=DOS lha v <
USER_LHA=
USER_WRI=write.exe <
USER_BMP=pbrush.exe <
USER_WAV=soundrec.exe <

[Classes]
* Function-classes used by View Files
Class_1=Archives,ARJ,ZIP,LZH,PAK,ARC,ZOO
Class_2=Programs,EXE,PIF,BAT,COM
Class_3=Documents,DOC,TXT,WRI,INI,RTF
Class_4=Sources,PAS,RES,RC,H,C,ASM,BAS,DLG,FRM
Class_5=Graphics,BMP,GIF,PCX,TGA,RLE,ICO,FLI,WPG
Class_6=Soundfiles,WAV,ROL,VOC,MDI,MOD,SND
Class_7=Drivers/DLL,DLL,DRV,SYS
Class_8=Fonts,FON,FOT,TTF,ATM,PFB,PFM



WINCATRS.BAT
echo off
rem    This BAT is used by WinCat when restoring files.
rem    Change the following statement to your directory containing
rem    unarchive utilities like LHA.EXE, ARJ.EXE and PKUNZIP.EXE :

cd\shez  <--- specify directory of unarchive utilities

echo %1 %2 %3 %4 %5 %6 %7
%1 %2 %3 %4 %5 %6 %7

echo press any key to return to WinCat...
pause >nul



About Archive Files
Archives are files that contain other files.    Typically, the files in an archive are compressed.   
Archives usually have filenames ending with ZIP, ARJ etc., depending on the program they 
were created with.
Archives make it easy to group files, make transporting and copying these files easier, and 
(because the files are compressed) take up less space on your disks. 

WinCat can determine and catalog which files there are in these archives : ARJ and    ZIP 
(currently the most commonly used archive formats) and LZH, PAK, ARC and ZOO (less 
frequently used formats).

In order to create and extract archives, you need the appropriate DOS utility programs :

ARJ : ARJ.EXE (by Robert Jung)
ZIP : PKZIP.EXE and PKUNZIP.EXE (by PKWARE, Inc.)
LZH : LHA.EXE (by Haruyasu Yoshizaki)
ARC : ARC.EXE (by System Enhancement Associates)
ZOO : ZOO.EXE

Note : WinCat uses it's own routines to determine the contents of these archives ; it doesn't 
need the DOS utility programs to do so.

There are also several Windows programs available that either process archives themselves,
or that serve as a 'front end' for (i.e. make use of) the DOS utilities :

WinZip by Nico Mak Computing, Inc.
WinZip can create and extract ARJ, ZIP, LZH and ARC archives.
For handling ZIP files it uses it's own routines ; to handle the other archive formats it needs 
the appropriate DOS utilities.

Windows UnArchive (WUNA) by James N. Hughes
WUNA can extract ARJ and ZIP archives. It uses it's own routines to do so, so it doesn't make 
use of the DOS utilities ARJ.EXE and PKUNZIP.EXE

You can download these ShareWare programs from most Bulletin Board Systems. 
Note : these programs are not free software. As with all ShareWare, if you use these 
programs you should register them with the appropriate author.



Automatically Opening a Catalog
Normally, after you've started WinCat ,you must open a catalog by clicking the Catalog 
menu, and then selecting either the 'Open Catalog...' option, or selecting one of the 
catalognames at the bottom of this menu.

There are two ways to make WinCat open a catalog immediately upon startup :

The first way is to define filename-extension CAT to the Windows FileManager application 
and to associate WINCAT.EXE with that extension. 
Then, when you double-click a file named *.CAT on the FileManagers' display, WinCat will 
start and open the selected catalog immediately.
Use the 'Associate...' option from the Filemanagers' File menu to define the CAT association.

The second way to make WinCat open a catalog immediately when starting it, is to include 
the name of the catalog to open on the Program Managers' Program Item Properties window 
like this :

if catalog WINDOWS.CAT resides in the same directory as WINCAT.EXE :
 
Commandline : C:\WINDOWS\WINCAT\WINCAT.EXE  WINDOWS.CAT   

if catalog WINDOWS.CAT resides in another directory    :

Commandline : C:\WINDOWS\WINCAT\WINCAT.EXE  D:\DATA\WINDOWS.CAT

So, if you have multiple catalogs, you can define several WinCats to the Program Manager, 
and let each of them use a different catalog.
Then all you have to do is to click one of the WinCat icons, and the desired catalog will be 
opened immediately.



WOODLE : Designing and Printing Disklabels
WinCat/PRO comes with a separate utility with which you can design and print (adhesive) 
labels for the disks you've cataloged : the WinCat Object-Oriented Disk Label Editor 
(WOODLE).

With WOODLE's What-You-See-Is-What-You-Get editor you can easily define how you want 
your labels to look ; the printed labels will look exactly the same as how you design them on 
the screen.

WOODLE can print labels for 3.5" and 5.25" disks ; you can easily customize the number of 
labels that WOODLE prints on each page, as well as how they should be positioned on a 
page ; you can also adjust the size of the labels. This enables you to use use any stock of 
label paper.
    
To learn how to design and print your own labels, please read :

General usage notes Showing objects on labels
Customizing the layout of your labels Customizing picture objects
Defining the page-layout Customizing text-objects
Printing the disklabels Avery Labels
The WOODLE.INP input file



WOODLE : General usage notes
WOODLE prints your disklabels as graphics, not as plain text ; therefore your printer must 
support printing bitmap graphics in order to be able to use WOODLE.
The best results will be obtained when using a high-resolution printer, capable of printing 
300 Dots Per Inch (DPI) or more, for instance a HP DeskJet, HP LaserJet, Canon BubbleJet etc.

Modern matrixprinters usually are also capable of printing graphics, yet with a lower 
resolution (150 DPI or more), so the quality of the printed disklabels can be a bit 
disappointing.
Also it can take quite some time for a matrixprinter to print a page of disklabels. 

With WOODLE you can create full-color labels, but of course they will be printed in color only
if you have a color printer ; else they will be printed in gray-shades.
        
 WOODLE Installation 
1) put file WOODLE.EXE and file WOODLE.CFG in the C:\WINDOWS\WINCAT directory

2) add WOODLE.EXE to a ProgramManager's Group ; make sure to specify directory C:\
WINDOWS\WINCAT as the working directory, because else WOODLE will not be able to find 
and open file WOODLE.CFG.



WOODLE : Label Objects
On each label, you can optionally put one or more of these nine objects :
1. the disk's volume-ID
2. the disk's contents description
3. the disk's group-ID
4. the disk's location
5. the disk's owner
6. freeform text #1
7. freeform text #2
8. bitmap graphic #1
9. bitmap graphic #2

The objects 1 through 5 are 'fixed' text-objects ; you cannot define their contents yourself : 
WinCat will retrieve them from the WOODLE.INP file when actually printing the labels.
You can however change their appearance (like size and font) and position.

Objects 6 and 7 are 'user-definable' text-objects : you can define their appearance and 
contents yourself.

Objects 8 and 9 are picture-objects : you can define which BMP graphic they should show, 
and change their size and position.
 
You can select which objects to include on a label by clicking the 'Objects' menu, and 
(de-)selecting one or more of the listed objects. As you do this, they will (dis-)appear on the 
screen.

Their is in fact a tenth (text-)object ; this will always be visible on the label's 'backflap', right 
next to the WinCat logo. You cannot change it's position or size but, if    you are a registered 
WinCat/PRO user, you can change it's contents (to for instance your name and address). 
If you haven't registered WinCat/PRO, the text 'Unregistered Evaluation Copy' will be shown 
and printed on the backflap. 



WOODLE : Label Properties
WOODLE allows you to create up to six different layouts.
You can select a layout by clicking the 'Label' menu option, and selecting one of the six 
entries displayed on the menu.

To customize the label's background, select the 'Background' option on the 'Label'    menu.    

Size, description, border and other properties of a label can be defined on the 'Label 
Properties' window :

Description
The description you enter will be displayed on the 'Label' menu. You can use it to easily 
identify each of the six layouts you can create with WOODLE.

Label Properties

Include cover and backflap
When you check this option, WOODLE will print 70 x 70 millimeter (2.75 x 2.75 inch) labels, 
which you can fold over a 3.5" disk ; as a result of this the disks' volume-ID and description 
will show on the edge of it.
By turning off this option, the label will be adjusted in size to 70 x 53 millimeter (2.75 x 2.10 
inch) ; then it only covers the front of a 3.5" disk.
Note : this option is valid only for 3.5" disks.

Put backflap on top of label
If you also select this option, the backflap will be shown above instead of below the label ; 
this has the same effect as turning the label (or your terminal) upside-down.
Note : this option is valid only for 3.5" disks.

Hide border
Enabling this option will cause the label to be printed without a border-line ; on the screen, 
the border will be displayed in red instead of black.
You probably want to enable this option when using pre-cut labels (like Avery).

Rounded corners
Enabling this option will cause a border with rounded corners to be printed.

Label Format

3.5" diskette
Select this option to create labels for 3.5" disks. WOODLE will reset the label's size to 70x70 
millimeter (2.75x2.75").

5.25" diskette
Select this option to create labels for 5.25" disks. WOODLE will reset the label's size to 
125x35 millimeter (4.90x1.375").



Adjust Label Size
When using pre-cut labels (like Avery), it can happen that WOODLE's predefined sizes do not
exactly match the size of the actual labels.
In this case, you can use the Adjust Label Size option : it allows you to change width and 
height of a label in 0.01" increments.
See also Avery Labels



WOODLE : Customizing text-objects
You can include up to seven text-objects (selected on the 'Objects' menu) on each label.
Each object can be customized : you can change it's position, size and appearance, and for 
object #6 and #7 also it's contents.

To reposition a text-object, move the cursor right on top of it so it looks like a hand.
Then hold down the left mousebutton and move the mouse ; you'll see a box that follows the
position of the cursor.
Move the box to where you want to position the text-object and release the mousebutton ; 
the text-object will be drawn at it's new location.

To change the size of a text-object, move the mouse to either the right or bottom line of the 
box that's drawn around it, so the cursor looks the same like one of the 'resize' icons you see
when resizing a window.
Then move the mouse while holding down it's left button ; you'll see a new box that grows 
and shrinks while you move the mouse.
Make this box the size you want the text-object to be and release the mousebutton. The 
text-object will then be resized to it's new dimensions.

To change font, color, charactersize or alignment of a text-object, move the cursor right on 
top of it so it looks like a hand and click the right mousebutton once.
WOODLE then displays a window where you can set horizontal and vertical alignment 
options and, if you click the 'Font...' button, the font, color and charactersize to be used.
Note : best results will be obtained when using TrueType fonts, as these can be scaled 
without limitation ; standard fonts will look 'blocky' when printed.

On this window you can also change the contents of a text-object : however, this is only 
possible for the user-definable objects 6 and 7,    and for object 10 on the backflap.
You can use the backslash \ to split the text up into two or more lines.
 
Setting the Border option will cause a border to be printed around the selected object ; on 
the screen the border will be drawn as a black rectangle, instead of the red rectangle drawn 
around textobjects with no border.

Setting the Rounded corners option makes the object's border have rounded corners.

Setting the Transparent option will cause the object to be merged with it's background. This 
allows you to merge picture-objects with text-objects.      



WOODLE : Customizing picture-objects
You can include up to two picture-objects (selected on the 'Objects' menu) on each label.
Each picture can be customized : you can change it's position and size, and you can define 
which bitmap graphic it should display.

Changing position or size of a picture-object goes exactly the same as for text-objects : put 
the cursor on top of it and hold down the left mousebutton to drag it to another position, or 
move the cursor to it's right or bottom borderline and hold down the left mousebutton to 
change it's size.
WOODLE will stretch or shrink the picture to fit the area you defined.

To change the contents of a picture-object, move the cursor right on top of it so it looks like a
hand and click the right mousebutton once.
WOODLE then displays a window where you can :

- select a bitmap graphic by clicking the 'Open...' button
- edit the currently selected bitmap by clicking the 'Edit...' button. This will run the 
Windows PaintBrush application.

Setting the Border option will cause a border to be printed around the selected object ; on 
the screen the border will be drawn as a black rectangle, instead of the red rectangle drawn 
around picture-objects with no border.

Setting the Allow bitmap stretching option allows you to change the size of a bitmap.
If you turn this option off, WOODLE will print the bitmap in scale 1:1 ; for instance, if you 
select a 150x150 pixels bitmap, it will be printed as a 1 inch square bitmap on a 150 Dots 
Per Inch (DPI) printer, and as a 1/2 inch square bitmap on a 300 DPI printer. 

Note : WOODLE only supports black&white and 16-color bitmaps.



WOODLE : Print Disklabels
When you select the 'Print Disklabels' option on the 'Print...' menu, WOODLE will read the 
WOODLE.INP file created by WinCat/PRO, and commence printing the labels page by page, 
using the page layout as you defined it on the Define Page Layout window. 

If WOODLE cannot find or open file WOODLE.INP, the Print Disklabel function will terminate 
with    message 'Unable to open WOODLE.INP file'.

After reading file WOODLE.INP, WOODLE will switch the display to Preview mode and show 
each    page as it is about to printed, with a message 'WOODLE is ready to print page x of x. 
Do you want to print this page ?'.
Replies :
YES - WOODLE will print this page, and show you the next    page to be printed.
NO - WOODLE will skip printing this page, and show you the next page to be printed
Cancel - Will terminate the Print Disklabels function. 



WOODLE : Define Page Layout
Clicking the 'Define Page Layout' option on the 'Print...' menu will display a window where 
you can
- define the number of labels that WOODLE should print on each page
- define how the labels should be positioned on each page 

You can define how many labels to print on a page by specifying :

Nr. of labels to print horizontal
The number of labels to print next to each other. 

Nr. of labels to print vertical
The number of labels to print below each other.

The maximum values you can specify (these depend on the size of the individual labels, the 
top and left margins, the spacing between labels and the size of the page) are automatically 
set by WOODLE.
Every time you change one of the margin or spacing values (see below), WOODLE 
recalculates how many labels will fit on a page, and if necessary decreases the value you 
entered for <horizontal labels> or <vertical labels>.
You can see how many labels will fit on a page in the 'Current Settings' box (maximum 
number of labels to print H x V).

In this box you can also see what the usable print-area of the selected paper is ; note that 
this will always be less than the physical size of a sheet, because your printer uses it's own 
margin mechanism. Refer to the printer manual for more information on this.
Note that you can select another paper-size using the 'Setup Printer' option on the 'Print' 
menu.

You can position the labels on a page by specifying :

Top Margin:
The top margin is the distance in millimeters from the top edge of the usable print-area to 
the top edge of the first row of labels.

Left Margin:
The left margin is the distance in millimeters from the left edge of the usable print-area to 
the left edge of the first column of labels.

Vertical spacing:
The vertical spacing is the spacing in millimeters between the rows of labels.

Horizontal spacing:
The horizontal spacing is the spacing in millimeters between the columns of labels.

Click the OK button to accept the defined values. 

After defining the page layout, you can use the 'View page on screen' or 'Print sample page' 
options on the 'Print...' menu to see how a page of labels will be printed. 



WOODLE : Avery Labels
      
The Avery company supplies pre-cut labels in various formats. The ones most commonly 
used for 3.5" diskettes are :
#5196 : 2.75" square labels, 3 rows by 3 columns, Legal sheet 
#7664 : 70 mm x 71.9 mm, 4 rows by 2 columns, A4 sheet

When using Avery's #5196 (3x3) sheets, a slight problem occurs : the labels on these sheets
start at 3 mm (0.013") from the left edge of the paper, yet virtually no printer is capable of 
printing that close to the paper's edge... For instance, a HP-4L LaserJet uses a 6 mm (.024") 
left-edge margin, and there's NOTHING one can do about that (use of a screwdriver or slash-
hammer not taken into account).
So, because of the printer margins, it's not possible to print 3 2.75" wide labels next to each 
other.
The only way to make WOODLE print 3x3 labels is to decrease the horizontal width of the 
labels ; instead of printing them 2.75" wide, you must print them approx. 2.55" wide.    

To print labels 3 columns wide, you must do the following :

1. Select papersize Legal 8" x 11" using the 'Setup Printer' menu-option 

2. Specify these values on the Label Properties window :

Label Format 3.5" diskette
Hor. Size 255        <-- decrease the default width from 275 to 255
Vert.Size 275    
 
Hide Border Yes
Include cover Yes
Cover on top - optional -

3. Specify these values on the Page Layout window :

Top margin 5
Left margin 0
Vertical spacing 10
Horizontal spacing 4
Nr. of labels hor. 3
Nr. of labels vert. 3



WOODLE : WOODLE.INP file
On a label you can include objects like Volume-ID, Volume Description, Group etc.
When you design a label using WOODLE's editor, these objects are shown with sample text ; 
you cannot alter their contents. 
It's when actually printing the labels that WOODLE will retrieve the text to put in these 
objects from file WOODLE.INP. 
This file will be created for you by WinCat/PRO if you use it's Print Disklabels option, so if you
use WinCat /PRO you don't have to worry about this file.

It's only when you want to print disklabels without the help of WinCat/PRO that you should 
know more about how to create a WOODLE.INP file.

WOODLE.INP must reside in the same directory as WOODLE.EXE (else WOODLE can't find it),
and is a normal ASCII text file, which you can create with an ordinary ASCII editor like 
NotePad.
It contains one line of information for each label that should be printed ; if this file contains 
10 lines, 10 labels will be printed by WOODLE.

Each line in WOODLE.INP has this format :

Volume-ID<tab>Description<tab>Group-ID<tab>Location-ID<tab>Owner-ID

<tab> is the standard ASCII TAB character (hex 09).

The maximum length of each field is :

Volume-ID 11 characters
Description 51 characters
Group-ID 8 characters
Location-ID 8 characters
Owner-ID 8 characters

WOODLE will truncate fields that exceed the maximum length.






